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1. Release and version status

1.1.1s the VAPS available for BC/NAV, for cloud/on-prem, for all partners? And
when?

Learn about "all things availability" when it comes to the Visual Advanced Production Scheduler.

1.1.1. Is the VAPS available for Dynamics 365 Business Central and Dynamics NAV?

No, the VAPS is only available for Dynamics 365 Business Central. The minimum version required is
Business Central v14 (cu4).

1.1.2. Is the VAPS available for Business Central on-prem and cloud?

The VAPS is available both for Business Central on-prem and cloud.

1.1.3. Is the VAPS available for sale?

Yes, the VAPS is available for sale and to be implemented at and used by customers. Version 1.0 was
released on 17 January 2020.

1.1.4. Is the VAPS available for all NETRONIC partners?

No. The VAPS requires specific skills and expertise as it enhances and changes Business Central
significantly.

Please reach out to sales@netronic.com if you want to achieve the VAPS certification.

1.2.Where can | find the VAPS release notes?

Learn how to find the release notes for the Visual Advanced Production Scheduler. Learn how you
can check if you're on the latest version. Learn what is new.

The release notes of the Visual Advanced Production Scheduler can be found here:

https://www.netronic.com/microsoft-dynamics-365-business-central/visual-advanced-production-
scheduler/release-notes

2. Installing the VAPS

2.1.How can | install the VAPS in my on-prem environment?
Learn where and how you get the runtime package of the VAPS

First, you as a partner need to become "VAPS certified". Talk to sales@netronic.com to find out
details about the certification process.
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Once you are VAPS certified, you'll get access to our "NETRONIC VAPS Partner Community". It is
based on Microsoft Teams, and your place to go to get your demo version/ runtime package of the
product as well as Marketing and Sales collateral.

2.1.1.

2.1.2

=
.
—

Prerequisites to install the VAPS:

An up and running full-fledged Dynamics 365 Business Central Installation

Minimum required version: Business Central vi14 (cu4).

Access to the backend via the “Business Central Administration Shell” or the “NAV
Container Helper”

The Web Client needs to be enabled — and using the Web Client is highly recommended

. The VAPS D365 on-prem can be installed in two different ways:
I. THE NAVSERVER INSTANCE IS INSTALLED DIRECTLY ON THE COMPUTER

What is needed for the installation:

e Admin access to the NAV/BC server computer

e Access to the NAV/BC Admin Shell & Development Shell with admin rights on this
computer

e The “Name” of the NAV/BC Serverinstance into which the extension should be installed

e Anupdated NAV/BC license installed, which has the extension objects included

e Access to the NAV/BC Web Client to test the installation

e Access as “SUPER” user to NAV/BC, to assign Permission Sets to other users

Installation instructions:

e Run the "Business Central Administration Shell" as administrator and enter the following
commands:

e Publish-NAVApp -Serverinstance NAV -Path “NETRONIC Software GmbH_Visual Advanced
Production Scheduler_1.x.y.z_runtime.app” -SkipVerification

e Sync-NAVApp -Serverinstance NAV -Name “Visual Advanced Production Scheduler”

e Install-NAVApp -Serverinstance NAV -Name “Visual Advanced Production Scheduler”

e If the install call gives an error regarding “DataUpgrade,” try
Start-NAVAppDataUpgrade -Serverinstance NAV -Name “Visual Advanced Production
Scheduler”

Open the NAV/BC Web Client as user with “SUPER” permissions

Check the “extension management” page if the extension got installed properly

Check if you can open/run the extension

Assign the “NETRONIC VAPS” permission set to all users which should work with the extension.

Il. THE NAVSERVER INSTANCE IS RUNNING FROM A DOCKER ENVIRONMENT
What is needed for the installation?

e Admin access to server computer and the corresponding Docker environment
e Access to a powershell with the NAVContainerHelper module installed
e The “Name” of the NAV/BC Container into which the extension should be installed
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e An updated NAV/BC license installed, which has the VAPS objects included
e Access to the NAV/BC Web Client to test the installation
e Access as “SUPER” user to NAV/BC, to assign Permission Sets to other users

Installation Instructions:

e Please enter the following command with the help of the "NAV Container Helper":

e Publish-NavContainerApp -containerName navserver -appFile “NETRONIC Software
GmbH_Visual Advanced Production Scheduler_1.x.y.z_runtime.app” -skipVerification -
sync -install

o If the publish call gives an error regarding “DataUpgrade,” try
Start-NAVContainerAppDataUpgrade -containerName navserver -Name “Visual
Advanced Production Scheduler”

e Open the NAV/BC Web Client as user with “SUPER” permissions

e Check the “extension management” page if the extension got installed properly

e Check if you can open/run the extension

o Assign the “NETRONIC VAPS” permission set to all users which should work with the
extension.

2.2.How can | deploy the VAPS into a cloud infrastructure?

If you want to use the VAPS in a cloud environment you can download the app from Microsoft or
purchase it via your partner.

In both cases, the VAPS needs to be licensed. With the release of VAPS version 1.15.1.0, we have
implemented a new licensing system within the extension. This update is specifically designed to
ensure that proper licensing is maintained within SaaS environments. This also applies to existing
customers migrating to the new licensing system.

To ensure a smooth and fault-free licensing process, we've included the necessary steps for you in
the following instructions.

2.2.1. For existing customers migrating to the new licensing system as of VAPS version
1.15.1.1

How to license the VAPS - new licensing system .

2.2.2. For new customers wanting to purchase the VAPS via AppSource or directly
from NETRONIC

How to purchase and license the VAPS via AppSource or NETRONIC.

Available on

Microsoft AppSource
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DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

3. Look and feel of the visual schedule

3.1.Info window shows progress

When a simulation gets loaded into the VAPS, multiple stages of data processing are executed until
the visualization finally appears and the user can start working with it. Especially when there are
large amounts of data to be loaded/reloaded, this can take some time during which the users do not
know what is happening and are often unsure whether the application is still working.

To give the users more feedback as to what is happening during the loading process, we have
implemented a new info window that:

gives feedback that something is happening at all (meaning the extension has not crashed)
informs about the amount of data getting loaded, thus explaining why the process might take
so long

informs about how long this process might take and how long the users might need to wait
also helps our support team during customer trainings or support cases to get a better
understanding of the customers' environment.

View - Visual Advanced Production Scheduler

NETRONIC VAPS 5] Open in Excel Actions Fe

Capacities - Processing Activity: 1/4 Reading Simulation from Business Central

=
=
—

Working on it...

January 20

Work Center Group: 2 of 2

Work Center: 5 of 5

Machine Center: 14 of 14

Calendar Entry: 1698 of 2204 @
Production Order: 122 of 122

Production Order Line: 122 of 122

Prod. Order Routing Line: 588 of 588
Prod. Order Capacity Need: 1390 of 1390
Sales Header: 0 of 0

Sales Line: 0 of 0

Cancel
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The info window also shows up when you create, delete, copy, publish, and close (with saving) a

simulation.

Working on it..

Processing Activity: Simulation completely deleted
Work Center Group: 2 of 2

Work Center: 5 of 5

Machine Center: 14 of 14 )
Calendar Entry: 250 of 250

Production Order: 21 of 21

Production Order Line: 23 of 23

Prod. Order Routing Line: 115 of 115
Prod. Order Capacity Need: 226 of 226
Sales Header: 0 of 0

Sales Line: 0 of 0

3.2.The structure of the schedule

The VAPS provides you with a visual drag & drop frontend to manage your production schedule.

Since the VAPS is a Gantt Chart, it naturally has all its characteristics and elements:

Visual Advanced Production Scheduler 2 X
NETRONICVAPS | Actions ~  Fewer options 2
" B-bruary 2024 A~ ‘Man:h 2024
Capacities
Wk 05 | Wk 06 | Wk 09 Wk 10
o .
S i
4 Turning | Drehen = H E
Standby (e0) g 1 A 10 1¢ }
R R 1 1071 (¢ ¢
I 101076 ( ¢
i 101077 (| ]
CTX400 3 (] 4
CTX 2500 »
Beta 500 »
Beta 600 »
4 Sawing | Sagen »
Standby (o) d i 1c
Sow s v | T A0 ot aci o oo (i aa
4 Gear Cutting | Verzahnen »
Standby (e0) f 10 0110 101 1
101075 (80,
Il [iE
Aclive color mode: [tem View Active view filler: No view filter active Last EMAD calc. fime: 06.11.23 15:10 Last shopfioor update: 31.01.24 13:26

e Atime scale at the top.

o Atable at the left.

e On the right below the time scale, a diagram displaying the schedule with a calendar in the
background indicating work free periods in grey while working times appear in white.

e A menu ribbon is placed above the plan, the item “NETRONIC VAPS” summarizing all menu
options that we think are the most frequently used ones::
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NETRONIC VAPS | Actions ~  Fewer options

€ Undo 2@ Update Simulation > Apply Routing X Exit discarding changes 88 Sales Order View

» Redo % schedule Successers > Apply Alternative Routing @ Capac ty View 59 Production Order View
All options of the VAPS can be found under “Actions”:

uﬂgh _ li‘ s Einimﬂi . ‘;“h “ﬁﬂﬂiﬂi .

Visual Advanced Production Scheduler

MNETROMNIC VAPS | Actions »  Fewer options

Edit ?
Schedule >
4 Production
4 Turning | Dreher View >
Standby (oo}
Capacity Management »
Timeascale >
CTX400 | Calendar ’ 1401029 4 1010
CTX 2500 . View Filter EI 101021 (10107 10
| ) T
Beta 500 coarch 5 i101 osol (s 10103ﬂ

Beta 800 \ 4 I 1O TON023 (A5 RIOs ]

In case the “Actions” item is not visible in the menu ribbon, click “More options". To hide it
again, click “Fewer options.”

Please note, that, depending on the task you are currently working on (setting-up the VAPS,
working in a simulation etc., the contents of the menu ribbon will differ.

e A status area can be shown below the visual schedule, providing the planners with useful
information about
o the active color mode
o whether a view filter or the focus mode is active
o the last time the EMAD was calculated
o the last time the schedule was updated with shopfloor data
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T —

Standby (o)

CTX400
CTX 2500
Beta 500
Beta 800

4 Sawing | Sagen
Standby es)
Saw| Sage »

4 Gear Cutting | Verzahnen »
Standby es)

LC 500
Lc1e0

Phoenix

4 Milling | Frisen
Standby (o)

Wagner BAZ »
TC 229 Brother »
My very old mill (eff = 20%) »

vy B

Active color mode: Prod. Order Status

107018 (80) 401023 (0) | 40101107040{1010: 101046 @0}
101016 (7101021 (lﬂl 1011010 10109101041 (80) )
101031 {12 191037 { 101043 (50)

101011(€ 1 101€101030 (S0)

oot 40101 101023 (48) 101010108 101401042 (110)

| Adoiiioidoions o) [do1ddoidinaidoiod 120)  deiad0ncd doiodo oioea o) 01

A fie10 101018 80y
401067 40401012 @0) 40101  4t101028 (401030 (50)
101006 40102401025 (120)

10101010101038 (86)'

101 1017 (10101011 (80) 1010 101 101025 (1: 101028 (72)
o1 o1 101007 [70!‘ 101

Active view filer No view filler active

101101035 (65]‘n 16101101110 101033 (70)

io1ai foiom ¢4eosaso 4 10167 IR

" 11010109

Last EMAD caic. lime: 06.11.23 15:10

N
o d

| ]
i { [ (IR 108010
| 10107101071 (60)
| 101076 70}
| 101077 (50
doie  goiesecn I ([
1010101047 (100) :
doicionn
1417 Y, 101064)40)
(1] | 1108 (] B
T
@ G
| i
| i
o 101t foreti01022 (60) | 40119108 f01ia 10A101039 28) L 10 R 1010704120 101049
1011010101042 (110) R
101041 G101043 50) 10 108
() (ol

Last shopfioor update: 06.11.23 15:35

The status area is activated by default but can be switched off in the "Appearance" area of the

VAPS setup.

Appearance

Zoom Factor(%)
Layout

Tooltip Delay (ms)
Standby Color

Dateline Grid Mode

| 100|
| compact v|
| 1250
‘#FBFSBEQQ |
“u"l.l'eel-clg.r s |

3.3.Three different views

Weekend Coloring

Colorize Weekend
Weekend Color

Bar coloring mode

@

| #DFFAOF

|Graded

Hide Status Bar

)

There are three different views in the VAPS: the Capacity View, the (read-only) Production Order
View and the (read-only) Sales Order View.

You can switch between the views by the corresponding context menu items:

= NETRONIC
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View ~ Timescale ~~
B. Enable Focus Mode
Disable Focus Mode
& Show Setup Times

Hide Setup Times

Capacity View

B8 Sales Order View

88 production Order View

&} View Color Mode >

3.3.1. The Capacity View

The capacity view shows capacity loads of work centers and machine centers, grouped by work
center groups:

) Sa, 16.Jan 2021 | Su, 17.Jan 2021
Capacities
: : 00:00 |1200 |00:00 | 1200

4 Cutting > =
Loy
=

Standby (o0) E
G
w1
Cutting #1
Cutting #2
Cutting #3
4 Drilling 4
1.865
933

Select display mode for overlapping operations

Usually, overlapping operations are shown in an "optimized" way, meaning that the resource row
with the respective operations gets extended in height so that the operations are completely visible.
Since the VAPS schedules with finite capacity, overlapping operations are avoided, and hence this is a
rare case.

e
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However, some customers have contacted us with the following use case: They need to create
operations with a length of zero to define a common starting point for parallel routings without
blocking capacity. These operations will then be scheduled at the first possible position which will
result in a very high stacked resource. For these cases, we added two new context menu items so
that users can now decide whether overlapping operations are to be shown overlapped in one row
or stacked. This also applies to resources on Standby.

4 Milling & Turning (ca) ]

Standby (o0}

Fill Idle Times an this Machine Center

N Cefine additional Down Time

Define additional Up Time -

Edit additional Down Time

Remove additional Up Time

Sort Order

A Asss

Show operations overlapped in one row

p Asj| Show operations stacked

The picture below illustrates the different display modes:
Stacked view Overlapped view

‘10 =

Visualization of the field ""Earliest Start Date"*

The VAPS comes with the convenient automatic scheduling functions "Add all", "Fill idle times",
"Apply routing," and "Tighten operations". With the new version, users can limit these functions to
only schedule production order routing lines/operations so that they start at or later than the date
defined. This is done by the new field "Earliest Start Date" that has been implemented on production
order, production order line, and production order routing line level. Clicking an operation with an
earliest start date will display an according date line.
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Su Jan 14, 2024

1200 AN | 1200 P | 1200 AM | 1200 PR

A Inventory depariment

A Asseenbly department k
Standly (o}

Milie Seamares

Earfigit Stact Date 1010005 - 10

Lireclp Mitchedl

If the earliest start date is defined on all levels, the latest available date will be used for scheduling
and if the "Consider EMAD" option is activated, this date will also be taken into account, meaning
that the latest of all four dates will be considered.

Operations with an earliest start date can nevertheless still be dragged manually to an earlier start.

3.3.2. The Production Order View (read only)

The Production Order View shows production orders categorized by their status.

Production Orders (read-only) |

4 Flanned

4 Firm Planned

Schedulling 510

4 N0N000S Bicyde
« 101005 10001 1 T
10 (Wheel assembiy) I
30 [Chain assembly _
30 [Pinal assembly) m
A0 [Cortral) |

» 101001 Touring Bicyde —q— 4

100002 Bicyele
1011003 Bigyde

» 1011004 Bicyde

The categories are indicated by different colors:

p Planned

p Firm Planned
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Production orders, their production order lines, and production order routing lines are sorted in
ascending numerical order. Within each production order, the relating production order lines with
their production order routing lines are listed. The default sorting order for nearly all elements in the
plan can be changed either by context menu or via the “Configurations” tab in the VAPS setup.

| '€ 7z + fi] o/
VAPS Setup
MNew | Actions Fewer options
Configurations ~~ ==
#% Tooltip...
3M
#% Label..

#% Sort Order...

Configures the sort order.

€ Reset all configurations...

Consider EMAD when... ‘:) Consider Send-Ahead m
Consider EMAD when... m Scheduling 5tart (rela... 1D
Consider Queue Time - - (D Max. Number of Sche... 3

3.3.3. The Sales Order View (read only)

The Sales Order View shows those sales orders that have production orders against it and when
those production orders (lines) are scheduled. A visual alert is given if the production order's finish
date is past the sales order's requested delivery date.

Sales Orders (read-only)

4 1000120

et ot

10 (Wheel assembly) E

20 (Chain assembly) m

30 (Final assembly) 30 .

Required Due Date

40 (Control) t

50 (Packing table 1) E.

4 110020 by
4 101062 | 10000 | 20
10 (Rim assembly) E
20 (Drilling) 2
30 (Deburr)
40 (Machine Inspection)

50 (Wheel assembly)
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3.3.4. For better overview in large plans: the World View

Especially in large plans, it often happens that the planner loses herself a bit in the vastness of
operations. To help them find their way and to not lose track of the overall situation, we
implemented the "World View" that shows a small additional window underneath the actual plan
and is available in all three views described above.

By dragging the red rectangle in the "World View", you can quickly shift your focus to another part of
the plan.

View - Visual Advanced Production Scheduler < X
NETRONIC VAPS Open in Excel Actions  Fewer options
Edit  Schedule View  Timescale Calendar View Filter Search =
I e Focus Mode ﬂ“ﬁ.ﬂ““ﬁ.ﬁ!ﬂuﬂﬂ.ﬂ““k‘ﬂmﬂﬂﬂ!ﬂ.“ﬂ_ﬂl -
4 Machining 2 o
Disable Focus Mode = :E |
4 Cutting = &
[& Show Setup Times E E
2 | ®
Standby (o) Hide Setup Times | o
Cutting #1 show World View 1id oo 3 0 0 mﬂn‘ JHi0di30 Rido
Cutting #2 [& Hide World View o ?m ﬂ. maao Rilisor .wo.iq Bido 4@
Capacity View B
Cutting #3 2 Sales Order View 00| 0 I 'l R BN | | W B® EEpomie i
4 Drilling 28 Production Order View | 1
Standby (sc) W4, View Color Mode
- Al ~d ~ - . VAR AT —| - -
o
%
s
e

3.4.The time scale part of the schedule

The time scale is one of the three main areas in your schedule and is positioned at the top of the

view.

Capacities

Bn, 25. Jan 2021

00:00

Tu, 26. Jan 2021

12:00

We, 27. Jan 2021 Th, 28. Jan 2021

00:00 12:00 00:00 12:00 00:00

Fr, 29. Jan 2021

@

12:00

The time scale covers the period that was defined in the simulation's filter. This is the time from the
earliest date to the latest date.

= NETRONIC
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CREATE SIMULATION /

Saved Settings

Changes to the options and filters below will be saved only to: 'Last used options and filters'

Use default values from: Last used options and filters e

Filters

Description Simulation Created on 08/05,/20 10:10 AM
Minimum Status ¥
Earliest/Latest Date Input Type Absolute Date v

Earliest Date Formula

Latest Date Formula

Earliest Date 3/1/2020
Latest Date 3/31/2020
Default View Color Type ltem View ¥

3.5.Zooming and scrolling

The VPS offers various options of adjusting the size of your working area and going directly to a
particular place in your diagram.

3.5.1. Increase/reduce time scale solution

Depending on how much detail or summary is required, you can either increase or reduce the time
scale solution by mouse wheel or touchpad (move two fingers up and down on your touchpad)
within the time scale.
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Wednesday, 20. January 2021 Friday, 22. January 2021 Saturday, 23. hllﬂl‘m Sunday, 24. Jai
Capacities 3
01:00| 06:00 | 12:00 | 18:00 00:00 (06:00 (12:00 | 18:00 |[OC:00 |06:00 | 12200 |18:00 |00:00 | D6:00

4 Machining

4 Cutting »
Standby (oo}
Cutting #2
Cutting #3

4 Drilling »
Standby (o9)
Drilling #1 [ ]
Drilling #2

4 Milling & Turning 3

3.5.2. Show orders of a certain timespan only

A more precise way of showing certain parts of your plan is offered by the options of the "Timescale"
menu items. Click the according one to show either

e all orders of your current workday
e all orders within a week starting from the current work date
e all orders of a month starting from the current work date

[ | Actions Fewer options

Timescale
# Fit into View
¥ Scroll to Workdate
Scale to > 48 Work Day
B8 Work Week

M Work Month

3.5.3. Scrolling

The VAPS offers the following options for quickly navigating to certain positions in the diagram:

e the common scrolling options by vertical and/or horizontal scrollbar
e dragging the timescale either right or left
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e scroll directly to the Dynamics 365 Business Central work date by selecting the corresponding
item from the “Actions” menu.

| Actions Fewer optit

Timescale ~~
# Fitinto View

¥ Scroll to Workdate
Scale to >

|

3.5.4. Return to default time range

Select "Fit into view" to switch directly to the timescale as defined in the filter settings of the
simulation.

3.5.5. Search function

In both views, you can search for certain production orders:

Actions Fewer options

1escale - Search ~

#% Search Operation

Search Sales Order
I

e Inthe Capacity View, users can search for production orders and production order lines.

e Inthe Sales Order View, users can search for sales orders and sales item lines.

e The respective view then automatically scrolls to the first search result which gets
highlighted as well.
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O search BH Open in Excel

SEARCH SIMULATION ‘Z'
L.'yeneral
1
Status Filter None bl Prod. Order Mo. Filter |10‘I ody
Riouting
Prod. Order Reference Mo. Operation Mo
Status T Mo T T * T Description Starting Date Ending Date
-2 Firm Planned 101047 iopoo 10 Cutting #2 1/15/2021 1/18/2021
Firm Planned 101047 10000 20 Drilling #1 1/18/2021 1/19/2021
Firm Planned 1011047 10000 30 Milling #1 1/19/2021 1/20/2021
Firm Planned 101047 10000 40 Inspection Table #2 1/21/2021 172272021
Released 101047 10000 10 Drilling #1 1/28/2021 2/1/2021

40 |

|l | @]

The search dialogs can be personalized the same way as is known from Business Central by
adding columns in the fields list.

+ Field Clear personalization
O Search B Open in Excel More options Ny Add Field to Page X
SEARCH PRODUCTION ORDER LINE Place fields by dragging from the list to a
position on the page.
[General p
Code
Status Filter None v Prod. Order No. Filter Rk Variant Code Ready
|: Text
Description Ready
Status T Prod. Order No. t Line No. t Item No. Routing Reference No. Text
= Firm Planned : | 101023 10000 3001 10000 “f Description 2 Ready
Firm Planned 101033 10000 3002 10000 T
Firm Planned 101034 10000 3002 10000 Location Code Ready
Firm Planned 101035 10000 3006 10000 | Code
Firm Planned 101036 10000 3006 10000 Shortcut Dimension 1 Code  Ready
Firm Planned 101040 10000 1000 10000 [ Code
Firm Planned 101042 10000 1100 10000 Shortcut Dimension 2 Code  Ready
Firm Planned 101043 10000 1200 10000 E Code
Firm Planned 101044 10000 1300 10000 Bin Code Ready
Firm Planned 101045 10000 1300 10000 | [
Firm Planned 101046 10000 1300 10000 L Quantity Ready
Firm Planned 101047 10000 1700 10000 Decimal
Firm Planned 101048 10000 1700 10000 f Finished Quantity Ready
Firm Planned 101049 10000 1900 10000 Decimal
Firm Planned 101050 10000 1901 10000 | Remaining Quantity Ready
Firm Planned 101051 10000 1902 10000 | Decimal
Firm Planned 101052 10000 1903 10000 Scrap % Ready
Firm Planned 101083 10000 1000 10000 | .
Firm Planned 101054 10000 1001 10000 Due Date Ready
Firm Planned 101055 10000 1300 10000 - B
Starting Date Ready
Time
. = - Starting Time Ready
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3.6.The table part of the schedule

The table is one of the three main areas in your schedule and is positioned at the left. It shows your
resources grouped by work center groups, work centers, and machine centers.

3.6.1. The "Standby" resource

The standby resource does not exist in your Dynamics 365 Business Central work centers. It is a
virtual machine center that we automatically create in every work center. It contains all production
order routing lines/operations that are not yet scheduled from within the VAPS, and hence are just
scheduled by the Business Central scheduling run. The standby resource gets highlighted by a yellow
background and an infinity symbol next to its name:

February 2021

Capacities Wk 06 Wk 07 Wk 08
06 |07 08 09 10 11 12 13 14 15 16 17 18 19 20
4 Machining
4 Cutting »
Standby (eo) il 1
Cutting #1 » 10100/iefp1dioiforf ifi101018
Cutting #2 » fiig10d5
Cutting #3 »
» Drilling » 1010C107008 finot0m qi0101
i ac q i 101l

Please note that

o the standby resource always is treated as a resource with infinite capacity
e all other machine centers are treated as finite capacity resources)

3.6.2. Collapsing and expanding

Symbols located to the left of the work center groups and work centers provide the ability to collapse
or expand these centers. This feature allows you to conveniently hide or reveal specific details,
making it easier to navigate through the information presented in the table.

4 »

In the picture below, the work center group "Machining" is expanded, and the related work centers
are collapsed:
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< VISUAL ADVANCED PRODUCTION SCHEDULER | WORK DATE: 1/28/2021 ¥

NETRONIC Promoted Open in Excel Actions Fewer options

February 2021

Capacities Wk 06
4 Machining -
} Cutting » 101001cfp1diol A 1401101018
i iol
101005
» Drilling » qo10¢ 101008 f 1101011 diogl
i ®& i 101
101006
101005
» Milling & Tuming » i fio1008 fi jog it 10111010101
[] 1010057 (101008
fiog i
[
» Painting » 101008 ooz | o il it #8019/ io1006
101008 101008 (10100¢ 1
10100101009 1 101006
4 Assembly & QA |

Capacities
4 Machining
4 Cutting »
Standby (o) T 1
Cutting #1 » 1010 icb1dioiforf idi101018
Cutting #2 » fi 11005
Cutting #3 »
» Drilling » io10c101008 1101011 0161
i & i i

a0

Please note, that in collapsed work center groups, no operations are shown:

anuarg.tr 2021
Capacities k 03

» Machining

4 Assembly & QC
4 Assembly »

Standby (o0)

Assembly station #1

Assembly station #2
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The VAPS automatically saves the complete collapsed/expanded state of a view so that you can start
exactly with the status you saw when you left the view.

3.6.3. Show/hide the histogram

In the "Capacities" view, planners can easily get a visual representation of the workload by displaying
a histogram. To access this feature, simply look for the symbol located on the right-hand side next to
the name of the work center or machine center:

Cutting b

Clicking this symbol will either show or hide the capacity curve for this work or machine center. The
picture below shows the histogram for the "Drilling" work center:

Capacities

February 2021

4 Drilling

Standby (co)

Drilling #1

Drilling #2

» Milling 8 Turning

Actions

Edit

Schedule

View

Fewer options

Capacity Management ~

Timescals

Calendar

View Filter

Search

= NETRONIC

i

101009 {01008 | |ffi0io0e
[} il i©1005
101C 101008

Change Uptime >
Change Downtime >

Capacity Aggregation >

10101011

s

W By Week

. By Meonth

1101018

10100!

101005 [1C
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3.7. The graphical part of the schedule

The graphical part - the diagram - is one of the three main areas in your schedule and is positioned in
the middle of the view. It shows you which machine center is working on which production order
routing line/operation and when.

B January 2021 February 2021
Capacities i wk 05 Wk 06
1 26 101
' 1010 0 p
a
| q0102 .
{ (=]
Cutting #1 101027 4101028 ] ¢ ?
| . 2
—I = =
Cutting #2 01018 i 01007 i &
Cutting #3 10 ([ oioo: =
4 Diilling »
Standby (e0) 10 {16101 7061 01014
" o
Drilling #1 a0 i 101101027 101022 i o]
i
Drilling #2 d0i6)o1910]§10d 101023 fiio]
4 Milling & Turning »
Standby (o) JiE 91012 | MpordiER  f6iEhe
00
Milling #1 doiol [gjon i Ym 101022
Milling #2 . 101024 101 :
Turning #1 i 1 10102 w0l ﬁ
Milling & Turning 101 1010 ool o3 i
. . .

3.7.1. The elements of the graphical part in detail

Bars

Each production order routing line/operation of a production order is represented by a bar that is
either colored or white. The colored area of a bar indicates that this timespan is during the work time
of the underlying machine center. The white area of a bar indicates that this timespan is during the
non-work time of the underlying machine center (also see below "Calendar". The bar color depends
on the selected color scheme (see below).

The following information can be gathered from optical indicators:

e  Currently marked operation

0

e QOperation changed but not saved yet
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e Violated due date

e Violated routing links

e QOperations potentially scheduled outside the visible time range
In addition to being indicated by a warning symbol, these operations get moved to the
standby resource.
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e Pinned operations, production order lines, production orders

The context menu allows to pin the above elements so that they can't be moved.

' K
10 (105
! Unpin » E m

. Pinwith Capacity blocked * | Pin Operation with Capacity blocked

Pin without Capacity Consumption * | pin Prod, Order Line with Capacity blocked
Move to Standby * | Pin Production Order with Capacity blocked

Mavigation ¥

=
Schedule Successors
| Aoy Routing 101

Apply alternative Routing

Set Facus

Remowve Focus

Change Prod Order Status
{ Apply Shop Floor Changes

: Change Duraticn

| Move Pinned/Started Operation

| Standard MRP Behavior
Exclude from MREP
Include into MREP

The different options are visually indicated as follows:

e Pin without consuming capacity

oo |

e Pin consuming capacity

é:': N ETRON IC pace 28 or 152



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

o Link violation after having pinned an element. The picture below shows that the
predecessor of a pinned operation was moved behind this operation

e Setup times

The setup times can be visualized as light grey section at the beginning of the bar.

I

You can switch between showing and hiding the setup times by a menu item:

View Timescale
@ Enable Focus Mode

Disable Focus Mode

[& Show Setup Times

Hide Setup Times

Il'i View Color Mode

The color representing the setup time can be easily specified in the VAPS color settings:
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Color Setup

General
Default Item Celor w#OO0ER Default Production O... wO0O0ER
Default Maching/ Wor... #0005 Setup Time Color c0de

e Display mode for overlapping operations

Usually, overlapping operations are shown in an "optimized" way, meaning that the resource
row with the respective operations gets extended in height so that the operations are
completely visible. Since the VAPS schedules with finite capacity, overlapping operations are
avoided, and hence this is a rare case.

.20

_ 0 L —
T = m

However, some customers have contacted us with the following use case: They need to
create operations with a length of zero to define a common starting point for parallel
routings without blocking capacity. These operations will then be scheduled at the first
possible position which will result in a very high stacked resource. For these cases, we added
two new context menu items so that users can now decide whether overlapping operations
are to be shown overlapped in one row or stacked.

4 Milling & Turning (o) b

Standby (o0}

Fill Idle Times on this Machine Center

N Define additional Down Time

Cefine additional Up Time 1

Edit additional Down Time

Remove additional Up Time

Sort Order

A Asse

Show operations overlapped in one row

p Asj| Show operations stacked

The picture below illustrates the different display modes:
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Stacked view Overlapped view

3.7.2. Calendar

The grey and white area in the background visualizes the work and non-work periods of the
respective work/machine center. They are derived from the respective shift calendars.

Fr, 29. Jan 2021 Sa, 30. Jan 2021

00:00 12:00

I R R

Show/hide non-working times

Some planning situations require to focus on the working periods of a work or machine center only.

To show or hide non-working periods, click the "Calendar" item in the "Actions" menu and select the
desired option. This feature allows to hide or show the common non-working periods.

Actions Fewer options

mescale ~ Calendar ~ View Filter ~ Search v

U U U U
N i Show Non-working Periods i
- X Hide Non-working Periods
Non-working times are shown:
NETRONIC VAPS Open in Excel More optlons
e 03. Feb 2021 | Th, 04. Feb 2021 Fr, 05. Feb 2021 Sa, 06. Feb 2021 Su, 07. Feb 2021 Mo, 08. Feb 2021
Capacities
07:0] 12:00 00:00 12:00 12:00
4 Cutting
Standby (eo)
Cuttin #3 RS DN |
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Non-working times are not shown

NETRONIC VAPS Open in Excel Actions Fewer options
4 Cutting »
Standby (eo)
Cutting #2 10 i 10 -1( —w.aiu 10 410430 #10
30

e Handling of standby resources

Currently, the calendar of the related work center is applied to standby resources, so that
when the non-working period is hidden, the non-working periods that are shared by all
calendars will not be displayed and the timescale gets collapsed during these periods. On the
other hand, switching the non-working periods on means that those periods that are
common to all calendars will be displayed.

e Individual design of weekend colors and of date line grids

Some of our customers use a 24-hour working calendar and, as they told us, sometimes have
difficulties to navigate and plan by day in the diagram area because the change between the
days and/or weekends and working periods are not clearly visible. This, in turn, forces the
planner to constantly look back and forth between the timescale and the plan. So, we set to
work and implemented three new visual elements to create a better connection between
timescale and diagram area:

o vertical separation lines between individually selectable intervals
o individual background and bar coloring, and transparency degree for weekends
o anindividual background color and transparency degree for the standby resource

In the picture below, the date line grid mode is set to "Daily", the background color for the
weekend to a light blue, and the Standby color to a slightly darker yellow with a high degree
of transparency:
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NETRONIC VAPS Open in Excel | Actions Fewer options
Rnuary 2021 February 2021 L~ J
Capacities k02 Wk 05 wi
22 23 24 01 02 03 04 05 06 o7 os
4 Machining 2
o
£
4 Cutting » 2
=
Standby (o) 109 . -:I
Cutting #1 » 5
Cutting #2 » I I
Cutting #3 »
4 Drilling »
2 T aNal
Drilling #1 » 2( 10

The according settings can be found in the "Appearance" area of the VAPS setup dialog:

e Dateline Grid Mode

Dateline Grid Mode Daily v
Mone

Weekend Coloring Auto

Colorize Weekend P

Weekend Color ‘ #9FD7FA |

The "Auto" mode causes the grids to automatically adjust to the resolution of the time scale
resulting from zooming in or out.

e Weekend coloring

Dateline Grid Mode ‘ Daily V‘

Weekend Coloring

Caolorize Weekend ‘)

Weekend Color ‘#QFD?FA

If you want to color the weekends individually, you can activate this here.

o By clicking “...”you open the Color Picker dialog where you can
= select the desired color
= adjust the transparency:
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Color Picker | - 2 K

Selected Color | #oFD7FA

Kl -

= reset the weekend color to default comfortably and at one click:

Color Picker | - 7 X

Selected Color |#9FD?FA

Manage >
. &

Actions b Yd’ Reset Color to Default...
| |
Fewer options ® Reset color to default.
+ Show as menu I
[

“ can cel

(@]

Bar colors: Select individual bar color schemes that ensure that the label texts are
always visible.

Colorize Weekend ® )
Graded

Weekend Color Solid
Only Allocated Times

Bar coloring mode Graded v/

The options in detail:

= Graded (default): nonworking times are displayed in a lighter shade of the
main color; in case there are assignments during non-working periods they
are drawn in the main color

20 20 20 0 0 O A
i i
i

i
I10| :
i
| I | |
1

é‘zl: N ETRON IC paGe 34 oF 152



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

= Solid: draws a continuous block in the main color

=  Only Allocated Times: nonworking times appear with a white background

I
I I
fo Jio o i

o NN |
TCa N N

The procedure for editing the standby color is the same as for the weekend coloring:

e Standby color

Appearance

100 P4 Color Picker
STANDARD

A note on transparency: weekends, standby and calendar grids may overlap and by setting the
transparency, the user can determine what should be hidden or what should shine through. For
example, if you want to see the calendar grids or the weekends on the standby resource, you have
to make the standby color translucent accordingly.

3.7.3. Progress

For production order routing lines of released production orders, a progress bar can be displayed

below the actual bar being based on the posted quantity consumption or on the production time
passed

General

Progress Calculation Based on Time s

MNane
Bazed on Time
Based on Quantity

The color of the progress bar depends on the routing status and the percentage of completion:

e finished: black
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” u

e Status “none,” “planned,” “in progress”:

o Progress by quantity / by time < 100% : grey

o Progress by quantity / by time > 100 % : red

When attempting to move operations that are "in progress," a warning message appears, prompting
whether scheduling should proceed with the original quantity or with the current remaining quantity.
In the latter case, the input quantity will change, with a warning to the user that this action may
result in misleading progress bar information.

@ How should the input quantity of the changed operation be
handled?

Keep the current input guantity of 26.4
OR
Update the input quantity with current postings to 0

CAUTION: If the input quantity gets updated, the progress bar
information for this routing line will be misleading.

i® Keep the input quantity

() Update the input quantity

o I
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3.7.4. Links

Predecessor/successor relations are shown as arrows ("links") between the bars. They are only
shown for the production order that is currently selected.

e links between operations of one production order

]
-

o
o

e links between operations of different production orders if they are linked to each other by
reservations (make to order) OR links between production order lines coming from one
production order (make to stock)
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3.7.5. Work date

A red vertical line in the chart indicates the work date, this usually being the current date.

4 Drilling b

Standby (o0} i

Drilling #2

3.7.6. Required due date

The required due date is a specific VAPS field that you can set on the "Production Order" card:

Feguired Due Date 222021 =

This date can only be set and changed by the user. We recommend setting this date in case you have
hard due dates for one or more specific production orders.

a
4 Machining E
=F]
=
b Cutting b i -
a
=]
(]
a
- o
4 Drilling 2

3.7.7. Info symbol for additional information on operations

In Business Central, users can add additional information to a production order routing line by
creating comments, tool information, personnel information, and quality measure information that
are used, e.g., for describing certain specialties that need to be followed during the production
process. As this is, of course, valuable information, the VAPS helps the planner to quickly recognize
whether a production order line has such additional information so that the special requirements are
not overlooked.
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To activate this feature, tick the according option in the "General" settings of the VAPS setup dialog:

General

Hide Links between Production Order Lines @ Show Infosymbol on Additional Information

Show Symbol on Comment
Show Symbol on Tool Information

Show Symbol on Personnel Information

0c8

Show Symbol on Qlty Meas. Information

Shortcut to creating additional information

You can directly create and edit additional information by clicking the according item in the context
menu.

Unpin |_
007 - Pin with Capacity blocked

Pin without Capacity Consumption

Show in Sales Order View L

Show in Production Order View 1

Schedule Successors
Apply Routing
Apply alternative Routing

Set Focus -

Remove Focus 1

Change Prod Order Status
Change Started Operation

Change Pinned Operation

Standard MRP Behavior
& Comments

Tool Information

Exclude from MRP

Include into MRP Personnel Information

i/ Show Additional Information H Quality Measure Information
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3.7.8. The tooltip

The tooltip of the VAPS provides further details about an operation and is customizable.

MNo.:

ltem.:

Status:

MNo.:

Prod Order Description:
Last Date Modified:
Quantity:

Required Due Date:
Operation No.:

Setup Time:

Starting Time:
Starting Date:

Ending Time:

Ending Date:
Alternate Routing Set:
Category:

Work Centre:

Machine:

3002

3 Operations Subcontracing in Middle1 Operation Simple Subcontracting
Firm Planned

101034

3 Operations Subcontracing in Middle1 Operation Simple Subcontracting
04/14,/20

20

a1/28/21

20

10

11:50:00 AM

a1/27/21

1:50:00 PM

a1/28/21

Subcontractor 1

3.7.9. The "Standby" resource

The standby resource does not exist in your Dynamics 365 Business Central machine centers. It is a
virtual machine center that we automatically create in every work center. It contains all production
order routing lines/operations that are not yet scheduled from within the VAPS, and hence are just
scheduled by the Business Central scheduling run. The standby resource gets highlighted by a yellow
background (and an infinity symbol next to its name in the table part):

February 2021

Capacities Wi 06 Wik a7
4 Machining
4 Cutting ]
Standby (s 1 1
Cutting #1 v 604 it 4§ 1] iioi0s
Cutting #2 ¥ s i
Curting #3 v
# Drilling 13 101{l:1l:l1l:-35| il 101011 Ao
i ] 1 I donl

Please note that

e the standby resource always is treated as a resource with infinite capacity
e all other machine centers are treated as finite capacity resources )
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3.8.Navigating in the plan

The VAPS offers various options of adjusting the size of your working area and going directly to a
specific position in your plan

3.8.1. Adjust the time scale

Depending on how much detail or summary is required, you can either increase or reduce the time
scale solution by mouse wheel or touch pad.

3.8.2. Show operations of a certain timespan only

Click the according item to show either

e all operations of your current workday
o all operations within a week starting from the current work date
e all operations of a month starting from the current work date

Actions ~~ Fewer options
Edit 5 February 2024
Schedule >
! ﬂJ gt
! = I
en  \jew e i =] B
| o £
1 =]
Capacity Management > | =
| 3
Timescale > Fit into View
Calendar > ¥ Scroll to Workdate
View Filter e Scale to > ¥ Work Day 02
Search > E ¥ Work Week B
¥ 10 0:
W Work Month =
1 4 | |
3.8.3. Scrolling

The VIS offers the following options for quickly navigating to specific positions in the diagram:

e the common scrolling options by vertical and/or horizontal scrollbar
e dragging the timescale either right or left by mouse
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e scroll directly to the Dynamics 365 Business Central work date by selecting the corresponding
item from the “Actions” menu.

Actions Fewer options
2024
Edit e
Wk 05
Schedule 5 & 26 27 28 29 30
! =
| =
hen  view > ! E
i =]
| =
Capacity Management > |
Timescale > B Fitinto View
Calendar > ¥ Scroll to Workdate Wﬁﬁ'}
Scrolls to th kdate.
View Filter > Scale to | Cro7s to e werkazEte
Search > |
L | i

3.8.4. Navigate within one routing

This function allows you to navigate in your plan easily and quickly, integra especially if you have long
routings with lots of operations. It can be found in the "Navigation" entry of the context menu.

3.8.5. Adjust the width ratio between table and diagram

You can modify the width ratio between the table and the diagram by moving the vertical splitter bar
between them.

3.8.6. Return to default time range

Select "Fit into view" to switch directly to the timescale as defined in the simulation's settings.

3.9.The histogram provides capacity information

A histogram offers visual decision support by showing impending capacity problems. In the VAPS, you
have the option to view histograms of work centers and their associated machine centers. These
histograms allow you to easily identify available capacities, as well as any instances where capacities
have been exceeded, indicated by red markings.

The histogram is a capacity utilization chart:

e The outer (black) line shows you the maximum available capacity per selected aggregation
(derived from the capacity of the underlying machine centers).

e The grey-filled area indicates how much of that available capacity will be utilized by the
current schedule.

e Thered area indicates that, according to the current schedule, you will need more capacity
than what is available on Friday, February 12th.
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February 2021
Wk 06 Wk 07
0§ 07 08

10 11 12

Capacities
4 Drilling 4
2,098 -
1,049 -
0
Standby (co)
Drilling #1 »
Drilling #2 »
» Milling & Turning »

4
1l

107009 101008 | fl#0i00s
[ ] i 101005
101¢ 101008

10101011

1«

mr——

1101018

10100!

101005 1€

By “Actions”-> Capacity Management” -> "Capacity Aggregation” you can select the aggregation that

fits your requirements best.

| Actions ~  Fewer options

Edit
Schedule

B View

Capacity Management >

Timescale

Calendar

View Filter

Search

Change Uptime >
? Change Downtime >
2 Capacity Aggregation > i 8y Second
2 - By Day
? ] By Week
L4
- By Month

3.9.1. Include/exclude standby operations for the load curve

Until version 15 of the VAPS, the workload shown in the histogram was determined by considering

both the scheduled production orders and those on standby, as shown in the picture below:

R R

However, we have recognized that our customers have varying preferences. Some require a
histogram that exclusively reflects the current workload, while others prefer to include standby

101062 (410105
101059 (50)

operations for a comprehensive view, enabling them to identify potential bottlenecks or unrealistic
delivery times. To accommodate these diverse needs, we have introduced a new switch in the VAPS
setup dialog. This allows users to specify whether they want to include standby operations in the

histogram or not.
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General
Hide Links betwesn P... @ Show Infosymbeol on Additional Information
Include Operations o... m Show Symbol on Co...

Show Symbol on Tool...

Show Symbol on Pers...

I0C8

Show Symbol on Qlty...

This is what our example from above looks like when the operations on standby are excluded from
the load curve:

4. The view color modes

The VAPS offers different views that let you stress different aspects of your plan by defining and
using certain colors for the bars depending on the things you want to highlight. This will help you
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tackle certain challenges and answer certain questions.

4.1.1. How to apply a view color mode

You can apply the view color modes in two ways:

When creating a new simulation, you can choose the desired mode as the default view color

type from a drop-down list:

Create Simulation X

Use default values from ’ Last used options and filters W ‘

Filters

Description lSimuIation Created on 16.11.23 14:51 |

Minimum Status ‘ - ‘

Earliest/Latest Date Input Type [Absolute Date v I

Earliest Date Formula

Latest Date Formula

Earliest Date \01.12.2023 | l

Latest Date 101.03.2025 o |
IProduction Line Assignment v I

Default View Color Type
Data Filter

No.

Name

Item View

Machine/Work Centre View
Prod. Order Status
Progress

Availability

Wait Times

Production Order View
MRP View

Shop Floor Status
Production Line Assignment
Production Line Sequence

In the visual schedule, select Actions --> View --> View Color Mode:
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METRONIC VAPS Actions ~  Fewer options

e Edit ?
Capacities
Schedule 2
4 Production i
4 Turning | Dreher View > @, Enable Focus Mode
Capacity Management > [&
Standby (o) Timescale ? [& Show Setup Times
Calendar > E}\
View Filter > [ Show World View
CTX400 Search > @
CTX 2500 4
I8l View Color Mode > & ltem View
Beta 500 »
Bata 800 ) Other > W Machine/Work Centre View
4 Sawing | Sagen 4 Prod. Order View
20
10 58 Prod. Order Status View
ool | [ ] _
Standby () ’ Progress View
Saw | Sdge 4 [efl Shop Floor Status View
4 Gear Cutting | Verzahnen » E_,' Availability View
Standby (o)
F’.—‘u Wait Times View
B MRP View
LC 500 4
LC 180 > B Production Line Assignmeant View
Phoenix 4 B Production Line Sequence View
4 Millina | Eriican 9 i

4.1.1. How to change the default colors of a view color mode

For changing the default colors of a view color mode, see this chapter.

4.2.The Item View (color mode)

The Item View helps you to focus on production orders for certain items.

The Item View highlights production orders for items that you want to visually stand out. For that
reason, you can define a default item color in the color setup and item-specific colors on the item
card.

The Item View is useful if you have certain items that require a
specific attention. This could e.g., be items for production orders
that are very time sensitive. Or it could be items where the cost
of material are very high.
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Important to know: the item color is applied to an entire production order (line).

4.2.1. How to change the default colors of a view color mode

For changing the default colors of a view color mode, see this chapter.

4.2.2. Change color for individual items

If, for some reasons, you want to highlight one or more specific items, you can do so by changing
their individual color on the respective item card:

Item Show more
No. Im ] El Base Unit of Measure |PCS v |
Description |Bicyc\e | Item Category Code | ~ |
Blocked CED) [coter vars) [#0cfis1 B
Type | Inventory v|

Example

The below screenshot shows a production schedule with the Item View applied. The following
settings are used:

o Default item color = grey
e |tem color "frame" = blue
e |tem color "rim for mountain bike" = red

January 2021 February 2021
Capacities Wk 05 Wk 06 Wk 07 Wk §
27 ‘ 28 29 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15
4 Machining i =
» Cutting ’ il omd G ot L S B |
ol i f |
» Drilling » (1ol 101007 | " T i od | ool ||po1mf1 [ |
10 l | foli @ | i
'z .
» Milling & Turning » f ] fo @ fdod 'ons! [ |
flipororo | i [ | f oo T
fi6of 5 [ |
) Painting » fior011 Bib{ @ rddfo| flofl@  fiioo2 i i
d filfioos [ |
10884 01009 Idi

4.3.The Machine/Work Center View (color mode)

The Machine/Work Center View helps you to focus on production orders for certain items. It
highlights production orders that are processed through certain work or machine centers. For that
reason, you can define a default machine/work center color in the color setup and e.g., machine
center-specific colors on the machine center card.

The Machine/Work Center View is particularly useful if you have
one (or a few) bottleneck resources that require your special
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attention. In such a case, you can make them visual stand out with

this view.

Important to know: the machine center color is applied to single
production order routing lines/operations.

4.1.How to change the default colors

For changing the default colors, see this chapter.

4.1.1. Change color for an individual Machine/Work Center

If, for some reasons, you want to highlight one or more specific machine/work centers, you can do so
by changing their individual color on the respective machine/work center card:

General
No. @ ]El Blocked @
Name |Cutting #1 | Last Date Modified 9/3/2019
‘Work Center No. |‘IOD v | Color (VAPS) ‘ e “
Search Name |CUTTING #1 |
Example

The below screenshot shows a production schedule with the Machine/Work Center View applied.
The following settings are used:

e Default machine/work center color = by production order status
e Machine center color for machine center "drilling #2" = red

Capacities
4 Machining
» Cutting »
4 Drilling »
Standby (e0)
Drilling #1 »
Drilling #2 »
» Milling & Turning »
b Painting »

January 2021
Wk 05

29

10101

1010
101

1
il

= NETRONIC

noj——|

30

10100

101010

101011

&l

February 2021
Wk 06

01 02 |03 |04

10 filed

10101

101¢ 101071 707¢
11

05

fo i

06

Wk 07
07 08 |09 10

1c

10 {0100 A A

i@od| ol '1\10101!1
[ | |

10

(&

fot
l

10100

01006
101010

10100 [fifiioo2

101008

14 15 16 17

Wk 08

Bt

1013 1op
101Ca
101005
1010

el

101008
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4.2.The Production Order View (color mode)

The Production Order View helps you to focus on certain production orders. It highlights production
orders that you want to visually stand out. For that reason, you can define a default production order
color in the color setup and production order-specific colors on the production order card.

The Production Order View is useful to recognize certain
production orders at a glance. This could be the case, e.g., if your
orders are typically both make-to-order as well as make-to-stock.

Then, if things get tight because a deadline approaches and you
need to shift out some order, you might want to shift out your
stock orders, because with them, there is usually more time

flexibility. If you have defined a unique color for your stock
orders you can quickly and easily recognize them.

Important to know: the production order color is applied to an

entire production order (line).

4.3.How to change the default colors

For changing the default colors, see this chapter.

4.3.1. Change color for an individual production order

If you want to highlight one or more production orders in your plan, because, perhaps, they are
urgent or belong to quite important customers, you can change the color on the Production Order

Card:
General
Ne. io104¢] Due Date 1/28/2021 ]
Description 1 Operation Simple Required Due Date 1/28/2021 (=
Description 2 Assigned User ID o
Source Type ltem Blocked @
Source No. 3000 v Last Date Modified 4/16/2020
Search Description 1 OPERATION SIMPLE Color (VAPS)
Quantity 180

Example

The below screenshot shows a production schedule with the Production Order View applied. The

following settings are used:

e Default production order color = blue

e Production order color for orders no. 101034 and 101036 = red
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Bnnday, 25. January 20| Tuesday, 26. January 2021 Weeﬂay_ 27. January 2021
Capacities
15:00 |18:00 | 21:00 | 00:00 | 03:00 | 06:00 | 09:00 | 12:00 | 15:00 | 18:00 | 21:00 | 00:00 | 03:00 | 06:00 | 09:00 | 12:00 | 15:00 | 18:00 | 21:00

4 Cutting 3
Standby (o9)
Cutting #1
Cutting #2
Cutting #3 [i01034 | (o036 |
4 Drilling 3

Standby (o)

Drilling #1

4.4.The Production Order Status View (color mode)

The Production Order Status View helps you to quickly see where in your scheduling & execution
process your production orders are. It differentiates production orders by their respective status and

lets you define different colors for the following statuses:

e Planned
e Firm planned
e Released

The Production Order Status View is particularly useful if you want
to quickly see where in your scheduling & execution process your
production orders are.

Important to know: the production order status color is applied to
an entire production order.

4.4.1. Change default colors

The picture below shows the default colors coming with the VAPS.

Production Status

Planned Production ... #obocff light blue Released Order #ffh366

Firm Planned Order #007acc dark blue

For changing the default colors, see this chapter.
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Example

The below screenshot shows a production schedule with the Production Order Status View applied

with the default colors coming with the VAPS.

January 2021 February 2021
Capacities Wk 05 Wk 06 Wk 07
27 |28 |29 30003 o1 |02 |03 o4 [os [ee o7 {os o9 |10 |11 |12
4 Machining ‘
» Cutting 1A filof ol fdoloos A @ ¢
| 10 f 401019
101009
» Drilling 101t 101007 flor+for [ | 10 101006 {07005 1 fio
101t 101007 10100 [ ] i a
10
» Milling & Turning 1t o4 fiod id 101 10100¢ fi A [1¢
1 10100 10100¢ fion 1010 ]1¢
i 101605
» Painting 101010 101009|10100 ¢4 01¢jfffj 002 o i@ iotooa o
101011 10101101¢4 101008 01008 101€40100 io
101004
4 Assembly & QA
) Assembly 10101011 101011 i
» QRA 1 foof | i 101§ 101
1010} 1 f 101008

4.5.The Progress View (color mode)

The Progress View helps you to quickly see which productions are late. This is both with respect to
production orders that start late and those that finish late. It differentiates production orders by

their lateness and lets you define different colors for the following statuses:

e Progress status missed. It indicates production orders that are planned to finish past a
requested date. Hence, this is the default color that is used if the end date of an operation is
past the required due date.

e Progress status not started. It indicates production orders that should have been started by
now but are not. Hence, this is the default color that is used if the start date of a planned
operation is before the current date/time.

e Progress status OK. It indicates those production orders that neither start nor finish too late.
Hence, this is the default color that is used if none of the above mentioned two colors get

applied.

The Production Order Status View is particularly useful if you

want to quickly see if you are running late.

Important to know: the progress status color is applied to an

entire production order.
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4.5.1. Change default colors

The below picture shows the default progress status colors coming with the VAPS:

Progress Status

Progress Status Missed #ff0000 red Progress Status Ok #04ff00 -

Progress Status Not S... ‘#ffg‘IOO orange ‘

For changing the default colors, see this chapter.

Example

The below screenshot shows a production schedule with the Progress View applied and using the
default colors coming with the VAPS:

February 2021

Capacities Wk 06
06
4 Machining =
> Cutting ’ fioild f@ofoos | @ @ 101
b Diiling » roiEl (% \ W oo ]
fofn @
» Milling & Turning » 101006 1 | fiG 101005 B [@ios |
fio10fill fi@noroos B
151 o- I
b Painting » 0701010021 o108 o100 -
I oo fOoGe | fiororo n
4 Assembly & QA
» Assembly » i fio1o0s |
flotoos |
) QaA » s 101002 [f] fio1011 |

4.6.The Shopfloor Status View

The Shopfloor Status View helps you to quickly highlight and recognize deviations between actual
data from the shopfloor and the schedule.

The Shopfloor Status View lets you recognize how incidents that happen
on the shopfloor impact your schedule.

Important to know: the shop floor status color is applied to an entire
production order routing line.
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4.6.1. Change default colors

The picture below shows the default colors coming with the VAPS.

Shop Floor Status

Plan Mot Changed C... ‘#ZOHEO ‘ Quantity Exceeded C... ‘ #fffb00 |
Start Changed Color ‘#‘ffEH 11 ‘ Plan Changed Color ‘ #ffbd00 |
Resource Changed C... ‘#ffDODO ‘

For changing the default colors, see this chapter.
Example

The below screenshot shows a schedule with the Shop Floor Status View applied with the above-
described default colors. Please note that this view also comes with a vertical line indicating when
the last “update according to actuals” was made.

B.I Jan 202
18{ 00: : : ! 5 "

Capacities
4 Production *E § | E
4 Turning | Drehen » g gi z
[=] = =
Standby (o0) = = i =
Wi =
@ @
]S
el e
5!
=
CTX400 4
CTX 2500 »
Beta 500 4
Beta 800 3
4 Sawing | Sagen »
Standby (o0)
Saw | Sige »
4 Gear Cutting | Verzahnen »

4.7 The Availability View (color mode)

The Availability View helps you to focus on the material availability of your production orders. It lets
you see which production orders have or don't have the needed material when the first operation is
meant to start.

The Availability is useful to recognize the material availability of
your production orders at a glance.

Important to know: the availability color is applied to an entire
production order (line).
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= Change default colors

The below screenshot shows the default colors coming with the VAPS:

Material Availability

Material Available #008000 Material Not Available #0000

For changing the default colors, see this chapter.
Example
In the picture below ,the Availability View is applied. The default settings are:

e production orders where the material is available = green
e production orders that are scheduled before the required material is available = red

January 2021
Capacities Wk 05

February 2021

4 Machining
4 Cutting »
Standby (e aE N m 1Ll
01 -
o

Cutting #1 28 -

Cutting #2 -01007 -

Cutting #3 - 1003 i -

4.8.The Wait Times View (color mode)

The Wait Times View helps you to recognize bottlenecks quickly and gives you an overview of critical
and uncritical waiting times of operations at the machines.

The idea behind this view: operations might need to wait for other

operations to finish as the other operations have (an implicit) higher
priority.

Important to know: the wait times color is applied to an entire
production order (line).

The below screenshot shows a production schedule with the Wait Times View applied. The default
settings are:

e no waiting times = grey
e waiting times, but the production order finishes in time = orange
e waiting time and part of a late production order = red
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We, 27. Jan 2¢ Th, 28. Jan 2021 Fr, 29. Jan 2021 | Sa 30, Jan 2021} Su. 31, Jan 2021 Mo, 01. Feb 202| Tu, 02. Feb 2021 We, 03. F
Capacities
03:19 1200 |00:00 | 1200 |00:00 00 (0000 |1200 |0000 [1200 | 0000 | 1200 |00:00 [12:00 |00:00
4 Machining
4 Cutting 13
Standby {(c0) 101012 1 10
101028
i |
Cutting #1 101027 107101028 1010¢
= ?
Cutting #2 | El 10°101C 1010075 1C
!
|
Cutting #3 RN} 101010 101003
i
4 Drilling » i
Standby (<) 101¢ 6104 (il
' 10 101 |
Drilling #1 10 88 o107 | 101 fiffoo |
T 1

4.9.How to change the default colors

For changing the default colors, see this chapter.

4.10. The MRP View (color mode)

The MRP View helps you to quickly differentiate production orders that belong to the VAPS area of
responsibility from those that belong to the MRP area of responsibility.

The MRP view lets you recognize production orders that are not touched
by the planning worksheet since they belong into the VAPS area of
responsibility.

Important to know: the MRP color is applied to an entire production order
(line).

The below screenshot shows a production schedule with the MRP View applied. The orders planned
by the VAPS appear in orange, the ones planned by MRP in blue.

anualy 2021 @Y | February 2021
Capacities k01 | wk02 Wk 03 wk 04 wk 05 Wk 06
1]12 13|14 |15 18|19 |20 | 2122 25|26 |27 | 28|20 o1|02|03 |04 |05 08|09 (10|11 |1
4 Assembly » E ‘ g
o &
g =
Standby (e0) 3 | g
=+ I e
5 o
Assembly station #1 3 EI:I ‘ ! '[ I I g
| S
Assembly station #2 E _ I l po E . . 1
Assembly station #3 ] 6y [ 'd It
I
pssemy ision ¢4 = eI
4 Quality Control 3 i
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The darker red shows that for this production order you have set an exception to the standard rule
by context menu

EmE B

4.11. How to change the default colors

For changing the default colors, see this chapter.

4.12. The Production Line Assignment View

The Production Line Assignment View lets you quickly recognize assignment errors when you work
with production lines.

If you work with production lines, the Production Line Assignment View will visually indicate if there
is a violation of the “line dependency” restriction, such as multiple operations from one production
order switching between lines.

‘.
4 Line3 >
Standby (c0) ]
Step 1
Step 2 « PO0004¢ P
Step 3 P000041 (36)
Step 4
4 line4
Standby (c0)
Step 1

N V| Y vl W

e A000041(16) o
PO00040 (35) P000041 (%

Step 3

vl V| v W

Step 4

Active view filter: No view filter active Last EMAD calc. time: 09.05.23 19:10

4.12.1. How to change the default colors

For changing the default colors, see this chapter.

4.13. The Production Line Sequence View

The Production Line Sequence View lets you quickly recognize sequence errors when you work with
production lines.

If you work with production lines, the Production Line Sequence View will visually indicate if there is
a violation of the “physical dependency” restriction, such as one production order overtaking the
other.
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4 Line 3 4 |‘
Standby (o) |
Step 1 > i POOG POCS POC-
Step 2 » !‘ P00004 1,
Step 3 > PO00041 (36)
Step 4 » POCS POQPO00042 (15)
4 Line4 »
Standby (<o)
Step 1 » P00004G, P&
Step 2 » PO00D40 (35 P000041 (16) o [N
Step 3 » P000040 (35) »P00004%
Step 4 » [Po0004 B¢
4 Assembly .

iter: No view filter active Last EMAD calc. time: 09.05.23 18:10 Last shopfioor update

4.13.1. How to change the default colors

For changing the default colors, see this chapter.

5. Setting up the VAPS

5.1.How can | define the default colors?

Define default colors at one central page so that you can quickly apply different color schemes in the
planning board.

The Visual Advanced Production Scheduler allows you to quickly change the coloring in the planning
board. This enables you to focus on different kinds of information at one glance - quicker. Overall, we
support the following color schemes:

e |tem view

e Machine/ work center view

e Production order view

e Production order status view

e Progress view

e Shopfloor status view

e Availability view

e Wait times view

e MRP view

e Production line assignment view
e Production Line Sequence view

All these color schemes are based on default colors. You can define them on the "color setup" page,
which you can access from the NETRONIC VAPS menu, or by simply searching for "color setup". The
color setup page looks as follows:
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Color Setup

Actions ~  Automate -~

»

General
Default Itam Color #0008ff Default Production O... #7bacd3
Default Machine/Wor... #0008ff Setup Time Color #d0dOe1

Progress Status

Progress Status Missed #ff0000 Progress Status Ok #04ff00

Progress Status Not 5., #ff3100

Shop Floor Status

Plan Neot Changed Co... #20ff20 Quantity Exceeded C... #fffb00
Start Changed Color #8111 Plan Changed Color #ffbd0O
Resource Changed C... #0000

MRP Domain >

Production Status >

Material Availability >

Waiting Times >

Workcenter

5.1.1. General information

You can define colors either by its hex value or by clicking the three dots in each color-related line.
This opens a color picker.

All colors that you define here are always only applied to the bars in the planning board. Hence,
these colors are used to determine the color or a production order routing line (operation) in the
planning board.

5.1.2. Specific settings and what they are for

Let's look at all the settings that you can make in more detail.
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General

Default item color: This is relevant for the Item View. This is the color in which every bar is
shown in the Item View. If you want to focus on certain items, you have to define item-
specific colors on the item page.

Default machine/ work center color: This is relevant for the Machine/ Work Center View.
This is the color in which every bar is shown in the Machine/ Work Center View. If you want
to focus on certain machines, you have to define machine-specific colors on the machine
center (or work center) page.

Default production order color: This is the color in which every bar is shown in the
Production Order View. If you want to focus on certain production orders, you have to define
production order-specific colors on the production order page.

Setup time color: The color being used for the small rectangle at the beginning of the bar
that visualizes setup times of an operation.

Progress status

These colors are relevant for the Progress View.

Progress status missed: Indicates production orders that are planned to finish past a
requested date. Hence, this is the default color that is used if the end date of an operation is
past the required due date. The required due date is a new data field provided by the VAPS.
It is fixed and will not be changed by any Business Central scheduling run. The "progress
status missed" color will be applied to all operations of a production order of which a
minimum of one operation ends past the required due date.

Progress status not started: Indicates production orders that should have been started by
now but are not. Hence, this is the default color that is used if the start date of a planned
operation is before the current date/time. The "progress status not started" color will be
applied to all operations of a production order of which a minimum of one operation ends
past the required due date.

Progress status OK: Indicates those production orders that neither start nor finish too late.
Hence, this is the default color that is used if none of the above mentioned two colors get
applied.

Shopfloor Status

These colors are relevant for the Shop Floor Status View

Here you can define the standard colors for deviations from the plan:
e No deviations

e Start date changed

e Changed resource

e Exceeded quantity

e Any other deviations from the plan

MRP Domain

These colors are relevant for the MRP View.

Specify the default colors for bars that are planned by MRP or by the VAPS.

Production Status

These colors are relevant for the Production Order Status View.
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e Planned order: Defines the color in which all planned production orders are shown.
e Firm planned order: Defines the color in which all firm planned production orders are shown.
e Released order: Defines the color in which all released production orders are shown.

Material Availability
These colors are relevant for the Availability View.

e Material available: Defines the color in which production orders are shown when the
material is available.

e Material not available: Defines the color in which production orders are shown when the
material is not available.

Waiting Times
These colors are relevant for the Wait Times View.

e Due date warning: Defines the color in which production orders are shown that have
operations that need to wait AND the production order runs late.

e Wait time warning: Defines the color in which production orders are shown that have
operations that need to wait, but the production order finishes in time.

e Wait time default: Defines the color in which production orders are shown that have no
waiting times.

Work center
e Subcontract work center color: Defines the default color for subcontract work centers.
Production Line

These colors are relevant for the Production Line Assignment View and the Production Line
Sequence View and are important when you work with production order lines.

Specify the default color for

e No conflict

e QOperations that are not assigned to a production line
e QOperations assigned to a wrong production line

e Operations that are sequenced in the wrong order

5.2.How can | define individual colors for specific items?

Define item colors on the item card. This helps you to make production orders visually stand out in
the "ltem View".

You can make production orders visually stand out in the Item View. That means you can define
specific colors for specific items that you do not want to be shown in the default item color.

You can do this from the item card. We added a color field to the item header.

You can either type in the color's name:
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& ITEM CARD | WORK DATE: 1/28/2021 —+ T
Process Item History Special Sales P...ces & Discounts Request Approval Show Attached
Item Show more
No. ‘ 1000 . | Base Unit of Mea... V |
Description ‘ Bicycle | Item Category Co... ‘ N |
Blocked @ - |
Type ‘ Inventory v

Or you can specify and color via color picker if you click the three dots at the end of the color field:

& ITEM CARD | WORK DATE: 1/28/2021

1000 - Bicycle

=

COLOUR PICKER

General

Process Iltem History Special Sales P..
Item

No. ’ 1000

Description ’ Bicycle

Blocked @ )

Type ’ Inventory

lnvsmmdmnns

This populates the color field with the respective hex code (you also can type in the hex code directly

if you know it):
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& ITEM CARD | WORK DATE: 1/28/2021 -+ [i]
1000 - Bicycle

Process [tem History Special Sales P...ces & Discounts Request Approval Show Attached

Item Show more
No. 1000 e Base Unit of Mea... PCS ~
Description Bicycle Item Category Co... ~
Blocked @ Colour #dedela

Type Inventory v

5.3.How can | define individual colors for specific machine centers?

You can make production orders visually stand out in the Machine/ Work Center View. That means
you can define specific colors for specific machine and/or work centers that you do not want to be
shown in the default item color. If an operation is assigned to that machine/work center, it will be

shown in the color you select for it.

You can do this from the machine/ work center card. We added a color field to the machine/work
center header.

e You can either type in the color's name:

& MACHINE CENTER CARD | WORK DATE: 1/28/2021 + Til]
Process Machine Center ~ Show Attached Navigate Fewer options
General
No. 1101 Blocked @
Name Cutting #1 Last Date Modified 5/6/2019
Work Center No. 1100 v Colour red
Search Name CUTTING #1

e Oryou can specify and color via color picker if you click the three dots at the end of the color
field:
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MACHINE CENTER CARD | WORK DATE: 1/28/2021

11071 - Cutting #1

Process Machine Center Show Attached
General

No. 1101

Name Cutting #1

Work Center No. 1100

Search Name CUTTING #1

COLOUR PICKER

General

This populates the color field with the respective hex code (you also can type in the hex code
directly if you know it):

é

MACHINE CENTER CARD | WORK DATE: 1/28/2021

1101 - Cutting #1

() + w®

Process Machine Center Show Attached Navigate Fewer options
General

No. 1101 Blocked @
Name Cutting #1 Last Date Modified 5/6/2019
Work Center No. 1100 v Colour #ed1010
Search Name CUTTING #1

5.4.How can | define individual colors for specific production orders?

If you want to highlight certain production orders you can define specific colors for specific
production orders that you do not want to be shown in the default item color.

This is done on the production order card where we added a color field to the production order

header.

Specify the color by either
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e Entering the color's name

€ FIRM PLANNED PROD. ORDER | WORK DATE: 1/28/2021

101035 - 3 Operations Subcontracting in Middle as Alternative

Process QOrder ‘ More options

jof

General

No. ‘10‘\035 Quantity ‘ 25‘
Description ‘ 3 Operations Subcontracting in Middle as Alternative | Due Date ‘ 1/28/2021 i ‘
Description 2 ‘ Required Due Date ‘1/28/‘202‘\ = ‘
Source Type ‘ Item Assignad User ID ‘ v ‘
Source No. ‘ 3006 Last Date Modified 4/16/2020

Search Description ‘ 3 OPERATIONS SUBCONTRACTING IN MIDDLE AS ALTEF| Color (VAPS) [purplel ]

e Clicking on
hex code will be entered.
e Typeinthe hex code.

5.5.How to configure tooltips

" in the color field and select the color via color picker - the color's respective

The tooltips of the VAPS provide further information on the following items of your production

schedule:

Machine Center
Froduction Order Line
Operations

5ales Order Status
5ales Order Number
5ales Line ltem Number
Sales Line Item Number
Work Center Group

Work Center

You can specify which information is to be shown in the tooltip of the respective item in the "Tooltip"
dialog - to be reached by clicking "Configurations" in the "Actions” menu of the "VAPS Setup" dialog:
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Mew Actions Fewer options

Configurations
7 Tooltip...
#% Label..

€ Reset all configurations...

TR TUIFTIIRRETON Y AT ATTIFT T %W

In the dialog popping up, you select the item for which you want to customize the tooltip and then
either delete, edit, or add fields and then click the “Edit” item from the “Actions” menu:

u]
o

/X

il
o
i

VIEW - SELECT TOOLTIP

Description

Machine Center
Production Order Line
Operations

Sales Order Status
Sales Order Number
Sales Line ltem Number
Sales Line ltem Number
Work Center Group

Work Center

The dialog “Edit — Define configuration” pops up.

i
it
N

EDIT - DEFINE CONFIGURATION

Production Order Line

Table Name Field Name
Production Order Line Status

Production Order Line Description
Production Order Line Prod. Order No.
Production Order Line Line No.
Production Order Line Starting Date-Time
Production Order Line Ending Date-Time
Production Order Line Due Date
Production Order Line Routing No.
Production Order Line Quantity (Base)

— |Produc1ion Order Line ] Routing Reference No.

Close
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Here you can:

e Add anew field:
either click +NEW or just click in the last row. You can select the desired Dynamics 365 BC

“" ”

data by clicking “...” either for table and field name.

AVAILABELE VALUES /

Value T
= Production Order

Production Order Line

e |Insert a new field:
Select the field above which you want to insert a new one and proceed as described above.
e Delete afield:

Click “*"and select “Delete line”
=% New Line |
. . i
= Delete Line
i
i

M Select More

5.6.How to configure bar labels

You can decide which D365 BC information is to be shown as bar label.
Bar labels are shown on

e operations in the Production View
e operations in the Capacity View

In the picture below, you see the bar label of a production order line in the Sales View, showing

e the production order number
e the number of the production order line
e the quantity

101053 | 10000 | 20
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You can specify which information is to be shown on the bar label of the respective item in the
according dialog to be reached by clicking "Configurations" in the "Actions” menu of the "Setup"

dialog:

Mew Actions Fewer options

Configurations ~
7 Tooltip...
/% Label..

€3 Reset all configurations...

R TITFETRIRREN AT Y AT ATTITET T W

e Inthe "View - select label" dialog, select the item and/or view for which you want to customize
the bar label - in our case "Production Order Line":

O Search [x:} Open in Excel More options

i
N
X

VIEW - SELECT LABEL

Description
Operation in Capacity View
Production Order Line

Operation in Sales View

Close

e The “Edit — Define Configuration” dialog pops up:
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O Search  —+ New B# Edit List ii] Delete A Move Up ¥ Move Down [z} Open in Excel
EDIT - DEFINE CONFIGURATION = k2 /‘

Production Order Line

Table Name Field Name
Production Order Line Prod. Order No.
VAPS Format Strings |

Production Order Line Line No.

VAPS Format Strings |

=3 Production Order Line ~] & Quantity (Base)

Close

e Here you can add, insert, edit, and delete fields as well as change their order. You can select the
desired table name and field name from your Dynamics 365 BC data by clicking “...”

O Search bz} Open in Excel

AVAILABLE VALUES /‘

Value t

Machine Center

Production Order

Production Order Line

Production Order Routing Line
= VAPS Format Strings

Work Center
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5.6.1. Formatting the labels

Separate the field contents in the table label by a line break, a blank or other separators by selecting
the according separator from the “VAPS Format Strings” table.

AVAILABLE VALUES
Value
MNew Line
Space
|
(
- )
P ]
= NETRONIC
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5.7. Configure table texts

You can decide which D365 BC information is to be shown as labels in the table for:

The picture below shows the table text for a production order routing line, containing:

Machine centers

Production order lines
Production order routing lines
Production orders

Sales order lines

Sales orders

Work centers

Work center groups

the operation number
a blank
the description in brackets

10 (Assembly station #1)

5.7.1. How to proceed

For customizing the table label, proceed as follows:

Click "Configurations" in the "Actions" menu of the "User Setup" dialog:

Available Values JORV

Value
Mew Line

Space
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e Inthe "View - select table text" dialog, select the item for which you want to customize the
table label which, in our case, would be "Production Order Routing Line":

View - Select Table Text 7 X
2 Search EE Open in Excel More options =
Description

Machine Center

Production Order Line
Production Order Routing Line
Production Order

Sales Order Line

Sales Order

Work Center Group

Work Center

The “Edit — Define Configuration” dialog pops up:

Edit - Define Configuration

S0 Search <+ New  EE Edit List il Delete A MoveUp W Move Down  EE Open in Excel

Production Order Routing Line

Table Mame Field Name
Production Order Routing Line Operation No.
VAPS Format Strings Space

— | Production Order Routing Line Description

Here you can add, insert, edit, and delete fields as well as change their order. You can select the

o ”

desired table name and field name from your Dynamics 365 BC data by clicking “...”.

5.7.2. Formatting the text

Separate the field contents by a blank, or by the separators shown below by selecting the according
character from the “VAPS Format Strings” table.
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AVAILABLE VALUES

Value

Space

5.8.How to use flow fields for tooltips, table, and label texts in NETRONIC'S
simulation tables

With certain conditions met, flow fields can also be created directly in NETRONIC's own simulation
tables, and be used for tooltips, bar labels, and table labels.

Important: Please note that only persistent records can be used as the foundation for calculating the
values in the flow field formulas. This means that values resulting from interactive rescheduling in
the planning board are not considered in the calculation. Additionally, there is no event triggered
before the flow field value is calculated, making it impossible to apply a date filter to restrict the
calculation to dynamic values, for example. Therefore, we recommend utilizing this feature only
together with values from standard Business Central tables.

5.9.The “General “settings

General
Hide Links between P... @ Show Infosymbol on Additional Information
Include Operations o... m Show Symbol on Co... m
Progress Calculation ‘ Based on Quantity v Show Symbol on Tool... @
Disable Warehouse A... m Show Symbol on Pers... @
Show Symbol on Qlty... @

e Decide whether you want to see links between production order lines or whether you want
to hide them.
e Choose whether standby operations are to be included in the histogram

e Select whether a progress bar is shown and hether the progress should be calculated based
on the time consumed or the quantity produced. The calculation of the consumed quantity is
derived from the input quantity, allowing consideration for scrap as well.
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Basad on Time

MNone

Based on Time
Based on Quantity

e Specify whether an info symbol will be shown on the according production order routing
lines when additional information was added to this routing lines in BC.

5.10. The “Scheduling” settings in the VAPS

The VAPS offers two semi-automatic scheduling tools, the functions "Add all" and "Fill idle times'
either with or without considering the EMAD. The settings described below make sure that these
functions work properly.

Scheduling Parameters

Consider EMAD Max. Number of Sche... ‘ 3

Consider Queue Time Add all default behavior for linked Production Orders

808

Default for Add unpla... o

D Default for Do not ad... @

Consider Send-Ahead

s

Scheduling Start (rela...

e Consider EMAD: Tick this option, if the EMAD shall also be considered when using "Add all" and
"Fill idle times.
o  With the function "Add all" you can schedule a bunch of production orders in one go.
o The function "Fill Idle Times" helps you to avoid idle times on machine centers and thus
fully use your capacities.

Recommendation: If material availability is crucial for you, switch on this option, so that you
never schedule without having material available.

e Consider queue time: Decide whether the queue time specified in Business Central on the
work/machine center card is to be considered for the scheduling process.

e Consider send-ahead time: Decide whether the send-ahead time specified in Business Central
when defining a routing is to be considered for the scheduling process.

e Scheduling Start: Here you can define the scheduling start for the two functions, starting from
the current work date. This will be indicated in the plan by a blue vertical line.
Recommendation: We recommend to initially set it to "2D" or "3D" to the short-term schedule
as stable as possible.

e Maximal Number of Scheduling Iterations: This option is mostly related to the "Fill idle times"
functions and lets you specify how often the scheduling process shall be carried out. No matter
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which number you have entered here, the process will be stopped, when it brings no more
change to the schedule.
Recommendation: We recommend starting with 5, if this takes too long, reduce to 3. But at least
enter 1 here.

e Add all default behavior for linked Production Orders: With this option you can determine the
default behavior of preceding and succeeding linked production orders when adding them from
standby to the plan.

5.11. How to set the parameters for EMAD calculation

When you want to setup an EMAD (= Earliest Material Availability Date) calculation, you need two
settings:

e Define the "Look ahead window" i.e., specify how far from now (= today) you would like to make
the allocation of component supply to component demand. This is done in the "VAPS Setup":

Material Availability

Look Ahead Window 3M Use Routing Links @
Lo

Exclude None-Inventory ltems

e Define which kind of demand type should get supplied first, second, third etc. This is done in the
"EMAD Demand" dialog under "Manage -> Edit List". Here you can also change the priority

order:
= EMAD DEMAND PRIORITY | WORK DATE: 1/28/2021 " SAVED D -
O Search - New B Edit List lil Delete B8 Open in Excel Y =
Priority Document Type t
= 1 Sales Line v
2
Service Line
Job Planning Line
Prod. Order Component
Assembly Component
Transfer Line
5.11.1. Consider EMAD on production order routing line level

Without any further specification, the VAPS calculates the EMAD on production order line level with
no EMAD per operation at all. You can, however, have the VAPS also consider routing links so that
the EMAD can be calculated by the production order routing line which means that a production
order line can be started even when the material for one (or more) operations is not yet available.

This option has to be switched on the VAPS Setup page:
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Material Availability

Look Ahead Window 12W Exclude None-Invent...
Use Routing Links Exclude Blocked Inve...
5.11.2. Exclude item type “non-inventory”

By clicking the according option, you can specify that the item type “non-inventory” is to be excluded
from the EMAD calculation.

Material Availability

Look Ahead Window 12W Exclude None-Invent...
Use Routing Links Exclude Blocked Inve...
5.11.3. Exclude blocked inventory

You can easily and quickly block certain lots from the EMAD calculation. This could become
necessary, e.g., if you have items the material of which is on-site but need a further quality
inspection. Then you could block them from the EMAD calculation, and we would treat them as not
available.

5.11.4. Exclude not fully promised receipt date from automatic functions like
Add All

You can exclude production orders without a promised delivery date from the planning with "Add all"
and "Add all incl. alternatives". You can still plan these orders manually per drag and drop. You can
still plan these orders manually per drag and drop

Material Availability

Look Ahead Window 12W Exclude Blocked Inve... m

Use Routing Links m Exclude Mot Fully Pro... m
Exclude Mone-Invent... m Include Fully Consum... m
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5.11.5. Include fully consumed items into EMAD calculation

Planners can decide whether to include or exclude fully consumed items into/from the EMAD
calculation by ticking the according option:

Material Availability

Look Ahead Window 12W Exclude Blocked Inve... D

Use Routing Links 0 Exclude Mot Fully Pro... @
Exclude None-lnvent... 0 Include Fully Consum... @

5.11.6. Consider EMAD in semi-automatic scheduling

The VAPS offers two semi-automatic scheduling tools, the functions "Add all" and "Fill idle times"
either with or without taking into account the EMAD. The settings below make sure that these
functions work properly. All settings can be found in the scheduling settings of the VAPS Setup:

Scheduling Parameters

Consider EMAD Scheduling Start (relative to Workdate) 1D
Consider Queue Time Max. Number of Scheduling Iterations 3

Consider Send-Ahead

511.7. Apply EMAD tolerance to an item

As is commonly known, the EMAD calculation provides a date from which the required quantity of
component demand is available and before which the production order must not start. The newly
implemented EMAD tolerance allows defining the criterion not too narrowly so that, e.g., an order
could already start if only 95% of the required material is available. To be able to do so, we have
enhanced the item card with the respective setting option. When calculating the demand, the
entered value is multiplied by the available quantity.

1001 - Touring Bicycle

Process Item Prices & Discounts Request Approval More options

Item Show more
No. 1001 Show in VIS @ )

Description Touring Bicycle Item Category Code v
Blocked [(CED)] Color (VAPS)

Type Inventory v EMAD Tolerance Percentage 5,00
Base Unit of Measure PCS v Exclude from EMAD (VAPS) @
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5.11.8. Run EMAD calculation from Job Queue

With the help of the Business Central job queue, you can schedule certain background jobs for
regular execution. The EMAD calculation, which until now could only be called via the VAPS
(interactively with - depending on the data volume - long calculation times), can now be triggered via
the job queue as soon as the VAPS is installed. Thus, it could be run at night, for example, without
supervision and without the need for someone to log on to the system to start the VAPS.

Setting up the job queue has to be done within Business Central by the administrator

5.12. Settings for integrating MRP/planning worksheet

Please note, that the concept of MRP/planning worksheet is described in detail in this chapter.

Here, you can:
o enable/disable the MRP/VAPS integration

o define a frozen period relative to the work date, meaning the period in which the VAPS is
responsible and production orders remain untouched by the planning worksheet.

MRP Setup

Enable MRP/VAPS Int... Frozen Period 2W

5.13. How to set up the automatic calculation of the earliest start date

Usually, the fields “Earliest Start Date” on production order, production line, and production order
routing line level have to be filled manually.

We have improved the handling on the production order level so that the “Earliest Start Date” on this
level can be calculated and filled automatically. In particular, customers who often have orders
whose required due date is relatively far in the future will appreciate this functionality.

The settings for this can be found in th area “Earliest Start Date Calculation” Here you can define
which mode of calculation should be used along with the associated custom values:

e None — same behavior as previously
Recommended usage: If the shopfloor can manage the current production order volume,
allowing for immediate ASAP planning without any need to “bench” tasks to align with
the required due date so that storage cost will be minimized.

e Simple Date Formula - will be applied to the “Required Due Date” to fill the Earliest Start
Date.
Recommended usage: If the shop floor must delay production orders to prevent long-
term storage of components or finished items until delivery, AND if the average
production order can be completed within a day or a few days of entering the shop floor
with minimal variation between orders.

e Weighted Production Order Time Demand - encompasses all times (setup time, run time
multiplied by quantity, wait time, and move time) to represent the total raw duration of
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the production order. This total is then multiplied by a user-defined factor and
subtracted from the "Required Due Date" in real time (without using work/shift
calendars).

Recommended usage: If the shop floor must delay production orders to prevent long-
term storage of components or finished items until delivery, AND if the average
production order spans several days, albeit with significant variation between

orders. Recommended multiplication factor: on a one-shift Mo-Fr shopfloor, a factor of
8 would give the best results.

The settings of the VAPS dialog are taken as default. However, users also have the option to
customize settings for individual production orders on the related production order card, which will
overwrite the default settings from the dialog.

VAPS
Color (WAPS)
Selected Earliest Calculati... Inherit from VAPS Setup o
|
Earliest 5tart Date Formula None
) Simple Date Formula
Weighted Demand Factor Weighted Prod Order Time Demand

This allows users to establish a "one size fits all" setting that applies broadly, while still having the
flexibility to apply unique settings for specific production orders.

The calculation of the Earliest Start Date will be performed:

e whenever a “Refresh Production Order...” is run

e on changing the required due date

e on changing the custom value (date formula or multiplication factor)

e on performing a new action “Recalculate Earliest Start Date” on both the production
order card and production order list as well as in the VAPS setup which the user can
activate

5.14. The “Sales order handling” settings

Decide whether you want to

e keep reservations when production order due dates get shifted
e show the sales order number on the production order line

Sales Order Handling

Change 5ales Lines @ Sales Order on Prod. ... @
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For more information, see here.

5.15. The “Appearance” settings

This area offers various setting options that affect the appearance of your plan

Appearance

Zoom Factor(%)
Layout

Tooltip Delay (ms)
Standby Color

Dateline Grid Mode

Here you can:

e Specify a zoom factor in percent.

‘ mo‘
| compacT v|
| 1250
‘#FBFSBBQE? . ‘
‘Weekly i ‘

Weekend Coloring

Colorize Weekend
Weekend Color
Bar colering mode

Hide Status Bar

@

| #DFFASF -]

‘Graded R |

@

e Choose a layout: In the "Compact" layout, the display is reduced as much as possible to
provide a better overview, especially with large plans.

o Standard layout, zoom factor 100 %:

Capacities

gnuary 2021
k02

4 Machining

4 Cutting

Standby (e0)

Cutting #1

Cutting #2

Cutting #3

4 Drilling

Standby (e0)

Drilling #1

Dirilling £7

= NETRONIC

Scheduling Start

20

20
20

il

10
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o Compact layout, zoom factor 100 %

4 Machining
4 Cutting
Standby (e2)

Cutting #1
Cutting #2
Cutting #3

4 Drilling
Standby (o)

Drilling #1

Drilling #2

4 Milling & Turning
Standby (o)
Milling #1

Milling #2
Turning #1

Milling & Turning

Scheduling Start

l@

10

30

o Standard view, zoom factor 80 %

Capacities
4 Machining
4 Cutting

Standbry (==}

Cutting #1

Cutting #2

Machine Center
No.: 120
Name: Cutting #2

Woaork Center Name: Cutting

Drilling #1

Drilling #2

4 Milling & Turning

Standby [=a)

Milling #1

Milling £2

Turning #1

Milling & Turning

= NETRONIC
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Scheduling Start
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e Specify a tooltip delay: give a time in milliseconds after which the tooltip shall appear

Appearance

Zoom Factor(%) 100 Tooltip Delay (ms) 750

Layout STANDARD

e Support of visual connection between timescale and diagram/ planning area
o Select an individual background color and transparency degree for the standby
resource. The procedure for editing the standby color is the same as for the
weekend coloring (please see description there):

Appearance

100 P4 Color Picker 7 X
STANDARD

DBDB0G,

“ Cancel

o Chose a date line grid mode for the vertical separation lines between individually
selectable intervals

Dateline Grid Mode Daily A

None
Weekend Colering Auto

Colorize Weekend Weekly

‘Weekend Color |#9FD7FA ‘

o The "Auto" mode causes the grids to automatically adjust to the resolution of the
time scale resulting from zooming in or out.

METRONIC VAPS Open in Excel Actions  Fewer options

Bm.m.s G W hursciay, 04.

| 1800| 2100

ay, 02. February 2021 Wednesday, ruary 2021

Capacities

00 06:00 | 09:00 | 1200 15:00 | 1800 21:00 | 00

00| 1500| 18.00 | 2100 | 000 20 rm)n‘ 1200 |'..m||

Standby (o0)

Drilling #1 Y |
Drilling #2 Y i
4 Milling & Tuming o

Standy (o)

Milling #1 v

o Make settings for the weekend coloring
= Decide, whether you want to color the weekends individually:

Weekend Coloring

Colorize Weekend m
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o Specify weekend color and transparency by clicking to open the "Color Picker"

Color Picker |

Selected Color

| #9FD7FA

o reset the weekend color to default comfortably and at one click:

Color Picker |

Manage
Actions
Fewer options

~ Show as menu

>
]

> Yo Reset Color to Default...

_Reset color to default.
I |

Selected Color

|#9FD?FA

“ Ca n(el

e Bar colors: Select individual bar color schemes that ensure that the label texts are always

visible.

Colorize Weekend

Weekend Color Solid

Only Allocated Times

s
Graded

Bar coloring mode Graded

The options in detail:

o Graded (default): nonworking times are displayed in a lighter shade of the main
color; in case there are assignments during non-working periods they are drawn in

the main color

= NETRONIC
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20 3 N 2 0 N A
i

Sch*@ng Start

Schefluling Start

—_

o Only Allocated Times: nonworking times appear with a white background

Scheguling Start

A note on transparency: weekends, standby and calendar grids may overlap and by setting the
transparency the user can determine what should be hidden or what should shine through. For
example, if you want to see the calendar grids or the weekends on the standby resource, you
have to make the standby color translucent accordingly.

e Show/hide the status area below the visual schedule

4 Sawing | Sagen »
Standby (ca)
Saw | Sage 3
4 Gear Cutting | Verzahnen 3
Standby (c2)

Active color mode: item View Active view filter: No view filter active Last EMAD calc. time: 06.11.23 15:10

Last shopfloor update: 31.01.24 16:32

= NETRONIC
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5.16. Show/hide the notifications window

When simulations get outdated or invalidated, e.g., when you add or delete production orders, the
VAPS shows a notification window, informing you about this:

X Simulation is outdated

If you don’t want this notification window to be shown tick the according option in the VAPS Setup
dialog:

Show Notification

Enable Motification

5.17. Define alternative routings/ alternative work/machine centers

You might have work/machines that can do the same job. With the alternate routing sets, you can
define these alternatives. Plus: you can also define production (and setup!) coefficients if some work
/machine centers can run faster than the others.

You can define alternative routings/ alternative work/machine centers on the "alternate routing set"
page, which you can access from the NETRONIC VAPS menu, or by simply searching for "alternate
routing set". The alternate routing set setup page looks as follows:

élzl:l N ETRON IC paGe 84 oF 152



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

< @ + i v Saved o /2

Alternate Routing Set

Related

Header

No. Version No.

Description Blocked

Alternate Routing Lines~

Setup Time

Type Center No. Machine Center Name Multiplier  Run Time Multiplier
= | Work Center ~| 100 Cutting 1 1
Work Center

Machine Center

You then can create a new alternative routing set by clicking the "+" icon which you find at the top of
the page. Then you need to give your routing set a unique number:

« ) + w /
Alternate Routing Set

Show Attached

Header

No. Set#1 - Cuttind Version No. v
Description Blocked @

After that, you can add all those machines and/or work centers to the alternate routing set that can
work as alternative resources within one routing.

However, you not just define the respective alternative resources. In addition to this you can also
define two different types of production coefficients:

e The setup multiplier
e The runtime multiplier
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2 ) + uw VSNED
Alternate Routing Set
Header
Description | Blocked ®

Alternate Routing Lines~~
MACHINE CENTER
NO.
1101
1102
1103

MACHINE CENTER NAME
Cutting #1
Cutting #2
Cutting #3

SETUP TIME
MULTIPLIER

1.00
1.25
0.80

RUN TIME
MULTIPLIER

1.00
0.80
2.00

In the above example, the alternate routing set "SET#1 - CUTTING" determines the following:

1. The machine centers 1101, 1102 and 1103 (cutting #1, cutting #2, and cutting #3) are

alternative machines.

2. The machine center cutting #1 is the reference machine (both setup time multiplier and run

time multiplier equal 1).

3. Cutting #2 takes 25% longer to set-up than cutting #1 but can run 20% faster (only takes 80%

of the run time).

4. Cutting #3 can be set-up 20% faster than cutting #1 but runs 2x longer.

Once you defined an alternate routing set, you can add it to any routing that you have.

= NETRONIC
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< ROUTING | WORK DATE: 1/28/2021 -+ [ii] / SAVED A
ER Copy Routing... Ml Versions €2 Where-used Show Attached Page Actions Navigate Report Fewer options ¢
General
No 1300 Search Description FRAME
Description Frame Version Nos. '
Type Serial v Active Version
Status Certified v Last Date Modified 7/20/2019
Lines Manage  Operation  Fewer options O

PREVIOUS  NEXT SE
OPERATI OPERATL... OPERATL... ALTERNAT.. DE..
NO. NO. NO. TYPE NO. DESCRIPTION SET SE.. SETUP TIME RUN TIMI
10 : 20 Machine Cent 1101 Cutting #1 SET#1 - CUTT... 60 1
20 10 30 Machine Ce... 1202 Drilling #2 30 1
30 20 40 Machine Ce... 1303 Mill & Turn 120 1
40 30 Work Center 2200 Q&A 0

The above example shows the routing 1300 for the item frame. Operation 10 by default is assigned
to machine center 1101 (cutting #1). However, you see that the "SET#1 - CUTTING" is also defined as
the alternate set.

When you now create a new production order using this routing, and when you then (re)calculate
the production order via the standard Business Central scheduling, the alternate set is added to the
production order routing line of that production order.

Consequently, all alternative machine centers will get highlighted when you drag operation 10 of the
routing in the planning board. Also, when you reassign it from cutting #1 to one of the alternative
machine centers, the setup time multiplier and the runtime multiplier will get taken into account.

6. Integrating with Microsoft Dynamics 365 Business Central

6.1.Integrating with Business Central standard manufacturing

The VAPS integrates with some standard Business Central tables & function:

e  Work/machine centers
e Shop calendars

e Production orders

e Routings

= NETRONIC
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6.1.1. How does the VAPS integrate with work/machine centers?

In the plan, work center groups, work centers and machine centers are shown as follows:

Capacities
=
4 Machining ‘ Work Center Group ‘ a
s
< cas : :
@
Standby (o) ‘ Machine Center ,Standby resource”, automatically added to each work center ‘ ?‘;
— o
cuir £ =
By double-clicking you can open the according Business Central card:
¥ €& . PROD.ORDER | WORK DATE: 1/28/2021 . Tii] -/ SAVED =

=

101035 - 3 Operations Subcontracting in Middle
as Alternative

Process Order ‘ More options ®
General
MNo. 1(]1(]35 ]El Quantity | 25|
Description | 3 Operations Subcontracting in I'v| Due Date | 1/28/2021 |
Description 2 | | Required Due Date | 1/28/2021 |
Source Type | Item V| Assigned User ID | o |
Source No. | 3006 ' | Last Date Modified 8/12/2020
Search Description | 3 OPERATIONS SUBCONTRACTIN| Color (VAPS) |#*3d00ff |
Lines Manage More options B3
Item Mo. Due Date Description Starting Date-Time Ending Date-Time Quantity
— 3006 +1/28/2021 3 Operations Subcontracting i... 1/26/2021 12:15 ... |1/27/2021 4:00 PM 25
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Shop calendars

In Business Central, the work times come via the work center. This means, that you have to specify a
shop calendar code on the Work Center card and this shop calendar code then defines the work
times/non-work times.

Scheduling
Unit of Measure Code -~~~ | MINUTES M ‘ Shop CalendarCode -+~~~ 1 ~ |
oty | 3 queetme
Efficiency -« - -+ - reeveeeeeieenns | 100 ‘ Queue Time Unit of Meas. Code
Consolidated Calendar ® 2 Two shifts Monday-Friday
+ New Select from full list
|

Please note that you need at least one shop calendar code. If you have multiple work centers with
multiple shifts you need multiple shop calendar codes.

Add capacity to machine center

In addition, you'll have to update the capacity of the machine center. The machine center inherits the
calendar of the work center, but you need to specify this on the machine center card.

CALC. MACHINE CENTER CALENDAR

Options

Starting Date [ 1/1/2021

Ending Date | 12/31/2021

Filter: Machine Center

—+ Filter...

Filter totals by:

=+ Filter...

Schedule... ‘ ‘

The capacity curve

The capacity curve shows the capacity of a work center group. It is calculated by taking the capacity
per day from the shop calendar and multiply it by the number of machine centers.
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February 2021
Capacities
4 Drilling 4
2,098 -
= T N .
0
Standby () l
u
Drilling #1 » 101009] {01008 | |ffd0i00e [1d0 101011 I
Drilling #2 » [} 8010050 i §  fooo)
» Milling & Turning » 101¢ 101008 fie flb100d fic

Add/remove work time

With the VAPS, you can comfortably define variations in capacity for multiple machine/work centers
or entire shifts in one go.

The VAPS lets you

e add/remove work time for multiple machine/work centers in one interaction
e add/remove work time for entire shifts by work shift codes for one or multiple
machine/work centers

Both options can be found under the "Actions" menu entry "Capacity Management"

| Actions ~ Fewer options
Edit 5 f 2024 February 2024
Schedule > -
i g e i
=3 !
en  View > i £ i
| ! = = !
Capacity Management > Change Uptime > Add Additional Uptime > By Date/Time
Timescale > Change Downtime > Edit Additional Uptime By Shift
Calendar > Capacity Aggregation | _
014 101040 (510102210
View Filter > | 0140103810
Search > . ﬁ 01030 (50) ﬂ m m i |

T | oigorczs e [ |foiosetoRiforgiato

In the picture below, downtimes have been added by date/time for two machine centers:
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Add Downtime by Date/Time s X
Downtime

Start Time 08:00:00 End Time 23:00:00

Timeframe

Start Date (0:1.03.202«1 i Capacity Type Machine Center v
gnd Date 08.03.2024 @]  capacity no. MO0OS0MO00G0

Absent Details

Absent Details Maintenance

This is what the result looks like:

IS,

4 Gear Cutting | Verzahnen

|
i Tl

Snehy () | P1152 (101155101156 (80) - acieen¢
Lc 500 BT 101801 (77) !
= i >—— i
LC 180 [ l A
Phoenix ! ’
1

In the "Edit" dialog, you can change all your up/downtimes:
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6.1.2. Production orders

Edit - Capacity Absence
L Search B¥ Editlist  [§ Delete Related
Starting Ending Time
Date t Time 1 T Description
> I 080000 130000  Wartung

04.03.2024 16:00:00 23:59:59 Lack of worker
05.03.2024 16:00:00 23:59:59 Lack of worker
06.03.2024 16:00:00 23:59:59 Lack of worker
07.03.2024 16:00:00 23:59:59 Lack of worker
08.03.2024 16:00:00 23:59:59 Lack of worker
04.03.2024 08:00:00 23:00:00 Maintenance
05.03.2024 08:00:00 23:00:00 Maintenance
06.03.2024 08:00:00 23:00:00 Maintenance
07.03.2024 08:00:00 23:00:00 Maintenance
08.03.2024 08:00:00 23:00:00 Maintenance
04.03.2024 08:00:00 23:00:00 Maintenance
05.03.2024 08:00:00 23:00:00 Maintenance
06.03.2024 08:00:00 23:00:00 Maintenance
07.03.2024 08:00:00 23:00:00 Maintenance
08.03.2024 08:00:00 23:00:00 Maintenance

Fewer options

Capacity

Upd..

No. 1

M00010
MO00040
M00040
MO00040
M00040
M00040
MO0050
M00050
MO0050
M00050
M00050
MO00060
MO00060
MO00060
MO00060
MO00060

N
X

B

Capar
Type

Mac

Mac

Mac
Mac

Production orders are represented in the VAPS by the bars of the single operations. Double-clicking a
bar will open the respective card:

The following production order data are visualized in the plan:

e production order number: displayed on the bars

e starting date/time - when the first operation of the production order starts
e ending date/time - when the last operation of the production order starts

e required due date, a field added by us : symbolized by a vertical line, shown for the

production order just selected

e order in which operations are worked off, coming from the routing - visualized by links

= NETRONIC
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Required Due Date

e Earliest start date calculation type: the VAPS allows to calculate the earliest start date on
production order level automatically. The default settings being valid for all production
orders are made in the according area in the VAPS setup dialog.

However, users also have the option to customize settings for individual production orders,
which will overwrite the default settings from the dialog.

VAPS
Color (WAPS)
Selected Earliest Calculati... Inherit from VAFPS Setup R
|
Earliest Start Date Formula None

) Simple Date Formula
Weighted Demand Factor Weighted Prod Order Time Demand

Detailed information about the automatic calculation of the earlies start date can be found
here.

6.1.3. Standby resource

The standby resource contains all production order routing lines/operations that are not yet
scheduled from within the VAPS, and hence are just scheduled by the Business Central scheduling
run.
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The standby resource gets highlighted by a yellow background (and an infinity symbol next to its
name in the table part):

February 2021

Capacities Wi 06 Wi 08
4 Matchining
4 Curting ]
Standby (=) T i
Cutting #1 b - it od i i o1 il 101013 :
Cutting #2 b | | o .
Custting #3 b
I Diilling ] - 11}1{I:1l:l1t¢8| 1 1'21':]'1? diogs
i i 1 ! i

You can also get an overview of orders that are not yet scheduled by the VAPS in the simulation data:

Schedu... f
by VAPS  StandBy |

6.2.0utput and consumption postings

Output and consumption postings can be seen as information about the progress of your production
execution. When you post output or consumption on your production order line you basically tell
your system that you started or finished an operation or that you have achieved a certain percentage
of completion.

6.2.1. Fundamentals on output/consumption postings:

e QOutput/consumption postings can happen very often, sometimes, even automatically
e They reflect a constant data updating process
e No impact on an existing simulation:
o The simulation doesn't get outdated
o The simulation doesn't get invalid
e The progress information you see in the visual schedule is about the moment in time when
you created your simulation.
e After posting output/consumption you have to create a new simulation
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6.2.2. The impact of the production order status

e You can only post output and consumption to a released production order
e Any output/consumption posting on a released production order results in showing a
progress bar in the VAPS

6.2.3. Visualization of progress information in the VAPS

For production order routing lines of released production orders, a slim progress bar is displayed
below the actual bar being based on the posted quantity consumption. The color of the progress bar
appears as follows:

e finished: black and grayed out

e still in progress and output/consumption <= originally planned quantity: grey

e still in progress and output/consumption > originally planned quantity: red

Please note, that

e you can only post output and consumption to a released production order
e QOperations that are already in progress, cannot be moved any more
e the percentage of completion is shown in relation to the net working time.

6.2.4. Special case: Posting on an operation that is still on the standby resource

This is a rare case that normally should not happen, but you need to be aware of it.
Important to know

e If you post output/consumption on an operation that is still on the standby resource, this
operation gets automatically moved to the machine center that is specified in the routing
because if an operation is started (what the posting means) it de facto cannot be on the
standby resource any longer.

o If there already is another operation on this specific machine, this could result in an overload
which the planner has to fix manually.

6.3.Integration with MRP/planning worksheet

The VAPS/MRP integration establishes clear rules as to which production orders belong into the VAPS
area of responsibility and hence have to be untouched by the planning worksheet.
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With this functionality we wanted to overcome the constant battle between planning and
scheduling, and the VAPS offers a close cooperation and interweaving between the finite capacity
scheduling (VAPS) and the planning worksheet (MRP).

The VAPS is responsible for the shorter-term finite capacity scheduling, whereas MRP and the
planning worksheet are responsible for the mid-term demand planning. The VAPS/MRP integration
establishes clear rules as to which production orders belong into the VAPS area of responsibility and
hence have to be untouched by the planning worksheet.

We determine this by two parameters:

e Timeframe (we introduce a "frozen period" as a period in which production orders will not
get changed by MRP)
e Production order status

The below chart summarizes these areas of responsibility:

PRODUCTION ORDER STATUS

Released Firm Planned Planned

VAPS

=

“Planning flexibility” i
VAPS i

simulation is published

MRP / planning

=

E and next regenerative wo rksheet

plan is created

=
=

In frozen
period

TIMEFRAME

VAPS MRP / planning MRP / planning

= worksheet worksheet

After frozen
period

6.3.1. Here is how we implemented this concept in the VAPS:

For the needed settings, we have implemented a corresponding area in the VAPS Setup dialog:

MRP Setup

Enable MRP/VAPS Int... Frozen Pericd 2W

Here, you can

e enable/disable the MRP/VAPS integration

e Define a frozen period relative to the work date, meaning the period in which the VAPS is
responsible and production orders remain untouched by the planning worksheet.

e Select the according options from the enhanced context menu which fits your situation to
allow deviations from standard rules concerning the VAPS/MRP integration:
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O

Unpin

30 o .
Pin with Capacity blocked

A0 Pin without Capacity Consumption

Show in Sales Crder View L

] Schedule Successors
Apply standard Routing

Apply alternative Routing L

' Set Focus

Remove Focus 1

Change Prod Order Status I

Standard MRP Behavior |

Exclude from MRP

Include into MREP i

e Check in the enhanced planning worksheet which production orders are scheduled by VAPS.

Acticn
Warning MNo. Scheduled VAPS Message
1000 Cancel
LS-10PC MNew
L5-10PC MNew
Emergency L5-120 Mew
LS-120 Mew
1 5-150 Mew

e When action messages are carried out, a warning message is given that this might change
production orders that are scheduled by the VAPS.
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Acti.,
Warning No VAPS Message Ref Line No.  Mes Date Due Date Starting Date-Time |

One or mare of the affected orders is already scheduled by VAPS.

Do you want to continue?
;\

e The color scheme "MRP" view helps you to quickly differentiate production orders that
belong to the VAPS area of responsibility from those that belong to the MRP area of
responsibility.

View ~ Timescale - Search ~

@ Enable Focus Mode

@ Disable Focus Mode

@ Show Setup Times

El Hide Setup Times

=) Capacity View

B8 Cales Order View

Il View Color Mode > Bl ltem View

§F Machine/Work Centre View

Prod. Order View

B8 prod. Order Status View

lafl Progress View

FE Availability View

ﬁ% Wait Times View

| = - —

EE MRP View

é:': NETRONIC pace 98 or 152



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

The darker red shows that for this production order you have set an exception to the
standard rule by context menu as described above

8 mE B

6.4.Integration with shop floor data

Customers need and want to update their schedule based on actual data and if unexpected incidents
happen on the shop floor, they want to quickly see the impact on the schedule. This is exactly what
the new functionality offers. For easy and comfortable use, we implemented the following features:

e (Capability to load recent shop floor data (capacity ledger entries) into simulation

e Special color mode “Shop Floor Status View” to highlight deviations between actuals and
schedule

e Option to (automatically) update the schedule based on actuals, either via the "Actions"
menu or via context menu color

o information from capacity ledger entries gets written into the production order
routing lines
e \Vertical line indicating when the last “update according to actuals” was made

NETRONIC VAPS Actions Fewer options
2 Edit > Load New Shop Floor Data et ARSI SURAE] Thursday, 04
Capacities
- Schedule Apply Shop Floor Changes
4 Production
4 Turning | Drehen  view Other
Standby (o)
CTX400 Capacity Management
CTX 2500 Timescale o~
Beta 500 =4
Calendar )
Beta 800 z
- View Filter &
4 Sawing | Sdgen fis
Standby (eo) Search .
Saw | Sage e " 11111101065 (80 101p77 (3110]073 (48)
. c—

6.5.Integration of sales orders and production orders

Planners do not want reservations between production orders and sales orders to break if there are
delays in production. Finite Capacity Scheduling Instruments. Instead, they want to quickly
understand which sales orders run late due to material and/or capacity constraints.

To solve these problems, the VAPS offers an (optional) integration of sales orders and production
orders with the following functionalities:

e The automatic shift of sales order expected shipment date in case production orders have to
get shifted
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e Reservation between production orders and sales orders is being kept although the
production order due date > original sales order expected shipment date
e Comprehensive report to see which sales orders have been shifted due to production order

shifts

Simulations

Alternate Routings  Color Setup
Sales Line Changes:  All £ search  [il Delete B3 Edit List
Shift Date-Time b £ Done Date-Time Done User

05.04.2023 16:46

VAPS Setup

B% Sales Order

EMAD Dema

More options

nd Priority

Sales Order Sales Line
Number Number
$Q:000016 10000 | 11.02.2024

Shifted

08.03.2024

Item No

P000007

Customer

The Cannon Group PLC Jo

This functionality has to be enabled in the "Sales Order Handling" area of the VAPS setup:

Sales Order Handling

Change Sales Lines

6.6.Show sales order number on production order line

Sales Order on Prod. ...

With this function we further expanded the integration of production orders and sales orders,
making the connection shown already on the according production order line card. What is more,
you can also directly open the sales order from here:

€ Firm Planned Prod. Orders

X Reminder: your work date is 31.01.2024

£ Search

@5 Change Status

womé;

101056
101057
101058
101059
101062
101064
101066
101067
101068
101069
101070
101071
101072
101073
101074
101075

101076

-+ New

Manage  Home  Reports
% Update Unit Cost..  [#] Statistics
Description Source No.
Prod 9 - type 5a P00000Y
Comp 0 - Prod 000009 - type 4~ COMP-P000Q...
Comp 1 - Prod 000009 - type 2 COMP-P000Q...
Prod 10 - type Tc PO000T0
Prod 11 - type 1 PO000T1
Prod 12 - type 7a PO00012
Prod 13 - type 2c P000013
Prod 14 - type 5d PO00014
Prod 15 - type 4b P0O00015
Prod 16 - type 3¢ PO00O16
Prod 17 - type 2f P0O00017
Prod 18 - type 1 PO00O1S
Prod 18 - type 1 PO00018
Prod 10 - type Tc PO000T0
Prod 19 - type 1 PO00019
Prod 20 - type 1 P000020
Prod 10 - type Tc PO00010
Prod 19 - type 1 P000019
Prod 20 - type 1 P000020

= NETRONIC

Use taday | Change to... | Turn off reminder

More options

Routing No.
P000009
COMP-P000Q...
COMP-P000Q...
P000010
P000011
P000012
P000013
P0O00014
P000015
P000016
P000017
P000018
P000018
P000010
P000019
P000020
P000010
P000019

P000020

Quantity

40

40

40

56

40

50

40

40

75

50

50

80

120

60

75

50

100

80

70

Starting Date-Time
04.03.2024 08:00
20.02.2024 12:19
20.02.2024 12:06
21.02.2024 23:06
12.03.2024 08:39
19.02.2024 13:19
08.02.2024 15:41
16.02.2024 15:08
21.02.2024 23:19
11.03.2024 08:00
13.03.2024 08:00
26.02.2024 20:29
22.02.2024 20:29
28.02.2024 22:10
27.02.2024 18:45
28.02.2024 13:55
27.02.2024 18:50
29.02.2024 21:50

01.03.2024 15:05

Ending Date-Time
07.03.2024 14:00
21.02.2024 23:06
21.02.2024 12:01
29.02.2024 13:52
14.03.2024 13:59
29.02.2024 08:12
14.02.2024 10:16
01.03.2024 08:12
04.03.2024 10:57
14.03.2024 10:09
18.03.2024 14:55
12.03.2024 15:19
13.03.2024 11:14
07.03.2024 16:00
07.03.2024 16:00
06.03.2024 16:00
12.03.2024 16:00
12.03.2024 16:00

12.03.2024 16:00

Due Date

08.03.2024

22.02.2024

22.02.2024

01.03.2024

15.03.2024

01.03.2024

15.02.2024

02.03.2024

05.03.2024

15.03.2024

13.03.2024

13.03.2024

14.03.2024

08.03.2024

08.03.2024

07.03.2024

13.03.2024

13.03.2024

13.03.2024

Assigned User
D

Status 1

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Firm Planned

Search
Description

PRODO-T..
COMPO - P..
COMP 1-P..
PROD 10 - ...
PROD 11 - ...
PROD 12 - ...
PROD 13 - ...
PROD 14 - ...
PROD 15 - ...
PROD 16 - .
PROD 17 - .
PROD 18 - .
PROD 18 - ...
PROD 10 - ...
PROD 19 - ...
PROD 20 - ...
PROD 10 - ...
PROD 19 - ...

PROD 20 - ...
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This function has also to be activated in the "Sales Order Handling" area of the VAPS setup.

Sales Order Handling

Change Sales Lines m Sales Order on Prod. .. m

6.7.Planning per sales orders

Sales orders can have different priorities and planners often like to schedule them en bloc based on
these priorities. This would ensure that the next free capacity is used in the best possible way for the
corresponding sales order.

But, however, what if a sales order consists of, let's say, 40 items that on the other hand lead to 40
production orders? This is where it gets difficult because these 40 production orders are on Standby
with the other production orders.

Two according options in the "Add all" and "Add all incl. alternatives" menus offer to solve this
problem:

‘ Actions ~~ Fewer options
Edit >
Schedule > Add Al > Add All from Standby

N View > Acld All incl. Alternatives > Add All from Selectad Production Orders
Capacity Management > Fill Idle Times Add All from Selected Sales Orders
Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues

View Filter > Move to Standby EIN(32) 101047 (100)
Search > Recalculate Current Schedule 1010g530) 101035990

¥ 101048 (70) 1010

- 104086 (30)

The options in detail:

e "Add all from selected production orders" shows a list where you can select from all
production orders where at least one operation is still on standby:
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Select Production Orders to be Added | . -

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder

No. Description ~ Source No. Routing No. Quantity  Starting Date-Time
— 101033 : Prod6 - Type 1a P000006 P000006 70,00 07.02.2024 09:34
101071 Prod 10 - type 1c POO0010 P000010 60,00 28.02.2024 22:10
101072 Prod 19 - type 1 P000019 P000019 7500 27.02.2024 18:45
101073 Prod 20 - type 1 P000020 P000020 50,00 28.02.2024 13:55
101074 Prod 10 - type 1c POO0O10 POQOO10 100,00 27.02.2024 1850
101075 Prod 19 - type 1 P000019 P000019 80,00 29.02.2024 21:50
101076 Prod 20 - type 1 P000020 P000020 70,00 01.03.2024 15:05
101077 Prod 10 - type 1c P000010 P000010 50,00 29.02.2024 17:00
101078 Prod 19 - type 1 P000019 P000019 30,00 04.03.2024 23:00
101082 Prod 21 - type 4d P000021 P000021 2500 12.03.2024 15:55
101083 Prod 5 - Type 2¢ P0O000S P0OQ0005 30,00 04.03.2024 19:30
101087 Prod 20 - type 1 P000020 P000020 34,00 15.02.2024 0&:11
101066 Prod 15 - type 4b P000015 P000015 7500 21.02.2024 23:19
101062 Prod 13 - type 2¢ P000013 P000013 40,00 08.02.2024 15:41

Ending Dat
01.03.202
07.03.202
07.03.202
06.03.202
12.03.202
12.03.202
12.03.202
07.03.202
07.03.202
14.03.202
07.03.202
20.02.202
04.03.202
14.02.202

e "Add all from selected sales orders" shows a list where you can select from all sales orders
with an assigned production order where at least one operation is still on Standby:

Select Sales Orders to be Added | 2 -

X Reminder: your work date is 31.01.2024  Use today | C A Move Up i
¥ Move Down
Status Ne. Eiﬁ::iegate “ ~ Show as menu
- Open + 50-000005 20.02.2024 32789456 Lovaina Contractors
Released 50-000011 08.03.2024 35122112 Bilabankinn
Released 50-000012 13.03.2024 41557832 Mabel Scherrer AG
Open S50-000014 15.03.2024 21245278 Maronegoce

7 X

Salesperson
Code

OF
OF
OF
OF

In both dialogs, you can change the order by "Move up" and "Move down".
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6.8.Use sales order line information in tooltip, label, and table texts

Tooltip, label, and table texts of production order lines can be equipped with information about
connected sales order lines.

Define Configuration 7

X

O Search + Mew EF Edit List [i] Delete 4 Move Up W Move Down

5
i

Production Order Line

Table Name Field Name
Production QOrder Line Status
Production Order Line Description
Production QOrder Line Prad. Order No.
Production Order Line Line No.
> Production Order Line ‘

NETRONIC VAPS Actions ~  Fewer options

bnuary 2024 February 2024
Sales Orders (read-only)
‘ Wk 03 ‘ Wk 04 ‘ Wk 05 Wk 06

4 Released
4 50-000002

Warkdate

4 PO00OT0| 56

4 101057 | 10000 | 56

Scheduling Start

Prod. Order Line
Status: Firm Planned
Description: Prod 10 - type 1c
Prad. Order No.: 101057
Line No.:
Connected Sales Lines: SO-000002 - 10000

p S0-000004

7. Finite capacity scheduling instruments

7.1.What is finite capacity scheduling?

The VAPS works with finite capacity scheduling. Finite capacity scheduling means to schedule with
limited capacities:

e |t makes sure that you do NEVER overload a machine center (exception see above under 7.2).
e Any change in the schedule leads to automatic recalculation of the entire schedule.
e This principle is also applied to complex routings:
o serial
o parallel
e Dependencies are considered:
o dependencies between operations (of one production order)
o dependencies between production orders (if made from reservations)

7.1.1. Working with infinite capacity on certain work/machine centers

As mentioned above, finite capacity scheduling makes sure that you do NEVER overload a machine
center. However, there are cases, where it could be useful to have work centers/machine centers

= NETRONIC
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with infinity capacity. Some customers have e.g., certain clearly defined bottleneck areas in which it
is imperative to plan with limited capacity and other areas in which it is perfectly possible to plan
with unlimited capacity. Moreover, in cases of orders being late, this feature helps to find out more
easily where the bottleneck is, based on the overload that has occurred (when setting a machine
center to infinite). The according option can be found on the respective work center/machine center
cards.

Scheduling

Unit of Measure Code MINUTES v Shop Calendar Code 2

Capacity 4 Queue Time 0
Efficiency 100 Queue Time Unit of Meas. ...

Consolidated Calendar @ Schedule with Infinite Capa... @

Having activated this setting will be indicated by the == symbol on the respective work/machine
center:

METROMIC VAPS Cpen in Excel Actii

Capacities

4 Milling & Turning (ca) ]

The behavior on such an "infinite" center is the same as on standby resources and subcontractor
work centers. Operations may overlap without driving out each other. Switching on or off this option
will affect the respective center in all existing simulations but operations having been scheduled
already will not be rescheduled automatically.

7.2.Move operations

Operations can easily be scheduled and rescheduled either interactively by drag & drop or via
context menu considering the rules of finite capacity scheduling.

7.2.1. Change timing of an operation

If you move an operation horizontally along the time scale, you'll change the timing. While moving
the operation, a “phantom” bar will remain at the original place until the mouse gets released.
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10702 -

i'9/01,/2021 10:00:00

Consider move and wait times when calculating ending date-times

The scheduling logic of the VAPS is adapted to that of Dynamics Business Central 365 so that also
move and wait times are taken into account for scheduling. In the picture below, operation 30 ends
at 1:00 pm and the following operation 40 starts at 1:30 pm. The tooltip explains the gap: operation
30 has a move time of 30 minutes which isn't visualized at the bar but gets considered for scheduling
and so the ending date-time of operation 30 is calculated as 1:30 pm.

307'._\
Prod. Order Routing Line 0 a
Status: Planned
Operation No.: 30
Prod. Order No.: 101001
Description: Deburr
Starting Date-Time: 01/19/21 11:55 AM
Ending Date-Time: 01/19/21 01:30 PM
Maove Time: 30
Wait Time: o
Previous Operation No.: 20
Mext Operation No.: 40
Production Order Line Line No.: 10000

7.2.2. Change resource of operation

If you move an operation vertically you can change the machine center where the operation is to be
worked upon. While moving the operation, a “phantom” bar will remain at the original place until
the mouse gets released.
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S M T
01

ol

27/01,/2021 15:05:02
—

28/01,/2021 10:05:02

7.2.3. Move operations that have already been started

Operations that have already been started, i.e., operations having postings already, can also be
changed interactively. For this, click “Move Pinned/Started Operation” in the context menu:

Workdate -

2
=1

[

We, 31. Jan 2024

00:00

Scheduling Start

, 01. Feb 2024

Fr, 02. Feb 2024

Unpin
Pin with Capacity blocked

Pin without Capacity Consumption

Mavigation

»

Schedule Successors
Apply Routing

Apply alternative Routing

- Remove Focus

Set Focus

- Change Prod Order Status

Apply Shop Floor Changes

Change Duration

o100 orcogenr

Move Pinned/5tarted Cperation

5

Standard MRP Behavior
Exclude from MRP
Include into MRP

Show Additional Information

The operation gets a red frame and can be moved to another point in time and/or another

machine center. :
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A
. i I
1

In both cases, the following dialog pops up:

How should the input gquantity of the changed operation be
handled?

@ Keep the current input quantity of 80

() Update the input quantity with current postings to 70

Here you can decide whether you want to schedule the operation at the new date and/or
place with the remaining quantity or virtually start anew with the original quantity. A possible
scenario for this could be that a machine broke down and the already produced items are
defective.

7.3.Change the duration of operations

The duration of operations can be changed interactively. For this, click “Change Duration” in the
context menu:
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NETRONIC VAPS

‘ Actions

Capacities

Beta S00
Beta 800

4 Sawing | Sagen
Standby (o0}

Saw | Sdge

4 Gear Cutting | Verzahnen
Standby (o0}

LC 500
LC 180
Pheoenix

4 Milling | Frésen
Standby (e0)

‘Wagner BAZ
TC 229 Brother

My very old mill (eff = 20%)

12 |13 |14 |15 |16

ot oGS rose s | 10907 615
o e o olondn

forossrs) 1 |

End of Frozén Period

ol

10100@

ol

March 2024

101

:@mm i

101075 (80)

101073 (50)
0107

4 Assembly
4 Assembly - Team 1

Standby (e0}

ﬁ1 032 (50) I

fo@e @ [ roosaso

7.3.1. Pin operations, production order lines, production orders

i

If you want to make sure that a certain element doesn't get moved any more by any automatic

scheduling, you can pin (and unpin) it by the according context menu option:

= NETRONIC
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' I
10 (105
{ Unpin ] E E

| Pinwith Capacity blocked * | Pin Operation with Capacity blocked |
Pin without Capacity Consumption * | pin Prod. Order Line with Capacity blocked
Move to Standby * | Pin Preduction Order with Capacity blocked
Mavigation *

Schedule Successors
| Apply Routing -

Apply alternative Routing

Set Facus

Remove Focus

Change Prod Order Status

| Apply Shop Floor Changes

: Change Duraticn

| Move Pinned/5Started Operation

| Standard MREP Behavior
Exclude from MRP
Include into MRP

i _.!1 NAR(70) 401049 £ 101(

These pinned elements can be seen as being dealt with manually by the scheduler working with the
VAPS

Allow moving of pinned operations

However, in case operations are dealt with manually, some customers need an extra portion of
flexibility as exception from the overall automatic scheduling. This is offered by the above-described
context menu item "Move Pinned/Started Operations" which allows to move a pinned operation
without unpinning it.

The according operation gets a red frame and can now be moved without any restrictions.

This means that it also can get placed manually in a way the automatic scheduler would never place
it. For example, you can drag & drop a pinned operation so that the start date of the successor is
before the end date of the predecessor.
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fe] B
[ —

7.3.2. Move (multiple) operations via dialog

Unpin ]

Pin with Capacity blocked ]

Pin without Capacity Consumption® £

Maove to Standby *

Mavigation »

Schedule Successors I
Apply Routing

Apply alternative Routing

Move Operation(s)

Set Focus

=

Remove Focus

Change Prod Order Status

o
[

Apply Shop Floor Changes

—4
=

Change Duration

Maove Pinned/Started Operation

Standard MRP Behavior l
Exclude from MREP [
Include into MREP

= Show Additional Information » a

With this function, you can move multiple operations individually, rather than as a single block.

By clicking the "Move Operation(s)” item in the context menu, the dialog "Select Production Order
Routing Line(s) to move" will appear, allowing you to precisely choose the desired operation(s).
Following this selection, all further adjustments can be made in the dialog "Move Production Order
Routing Line(s) Settings." Here, you can define parameters such as the new start date, capacity type,
target machine center, and more.

é:': N ETRONIC pace 110 or 152



DOCUM

NETRONIC VAPS Actions v Fewer options

Capacities

-

CTX400

CTX 2500
Beta 500
Beta 800

Standby (
LC 500

7.3.3.

7.4.5¢

A = " |
4 Turning | Drehen » |
Standby () | i

4 Sawing | Ségen
Standby (e0)

Saw | Sage > Move to Standby >

4 Gear Cutting | Verzahnen »

ENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

4
bruary 2024 L~ q
k06
o7 |o8 |09 |10 1l

= Unpin

Pin with Capacity blocked >

Pin without Capacity Consumption

Navigation >

Schedule Successors

- T Apply alternative Routing

(<)

Set Fodtis

Remove Focus

- Change Prod Order Status
Apply Shop Floor Changes.
Change Duration
- WMove Pinned/Started Operation
| Standard MRP Behavior
o
~ | includeintoMRP

| Show Additional information > |

— N ——

The underlying principles of drag & drop

The sequence on a machine can be changed.

Can have an impact on other machines (as successors might get moved).

We do not allow you to violate the routing structure (exception: if operations are pinned)
o predecessors will never be impacted
o right move -> successors will get moved
o left move -> successors will not get moved

hedule successors

With this instrument you tell the software to give the current production order the highest priority
from here. The function "Schedule successors" can be found in the bar’s context menu:

Pin with Capacity blocked

Pin without Capacity Consumption

Schedule Successors

Apply standard Routing

Apply alternative Routing

Set Focus

Remove Focus

h
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By ticking this item, you schedule all successors of the currently marked operation (if you marked the
first operation of a production order then, of course, the complete production order will get
scheduled).

7.4.1. The underlying principles of “Schedule Successors”

e Changes the timing (start date; hence: end date) of all successors.
e  Will not change the sequence on the machine where it is triggered.
e Has an impact on other machines (as successors will get moved).

e Will not violate the routing structure.

7.5.Apply standard routing

This instrument is meant to help you efficiently bring production orders from the standby resource to
a dedicated machine center.

The function "Apply Standard Routing" can be found in the bar’s context menu:

Unpin
Pin with Capacity blocked

Pin without Capacity Consumption

Schedule Successars

Apply standard Routing

Apply alternative Routing

Set Focus

Remowe Focus

By ticking this item, you add the operations of a production order to the schedule starting at least at
the current work date, or later, if requested by a linked predecessor without changing the schedule
and using the standard machines from the standard Business Central routing.

7.5.1. The underlying principles of "Apply Standard Routing"

e Changes the assigned machine center of the triggering operation and all successors (move
e from standby to a concrete machine center).

e Changes the timing (start date; hence: end date) of all successors.

e Adds this production order to the schedule with the lowest priority.

e Will not change the sequence on any machine.

e Will not violate the routing structure.

7.6.Apply alternative routing

This instrument is meant to help you efficiently bring production orders from the standby resource to
a dedicated machine center simultaneously looking for the best alternatives (i.e., earliest
completion)
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The function "Apply Alternative Routing" can be found in the bar's context menu:

I
Unpin

Fin with Capacity blocked

Pin without Capacity Consumption

Schedule Successors

Apply standard Routing

Apply alternative Routing

Set Focus

Remowve Focus

By ticking this item, you add the operations of a production order to the schedule starting at least at
the current work date, or later, if requested by a linked predecessor, without changing the

schedule but making sure that it will be finished as early as possible. For this, the alternative routing
you have defined will be used.

7.6.1. The underlying principles of "Apply Alternative Routing"

e Changes the assigned machine center of the triggering operation and all successors (move
from standby to a concrete machine center).

e Changes the timing (start date; hence: end date) of all successors.

e Adds this production order with the lowest priority applying an ASAP strategy

e Will not change the sequence on any machine.

e  Will not violate the routing structure.

7.7.Schedule production orders from standby in one go by the "Add all" function

With the function "Add all" you can schedule a bunch of production orders in one go, considering
alternate machine centers, if desired.

Production orders that are not yet scheduled in the VAPS, are shown on the respective standby
resource - a collection, so to say, of production orders that need to be added from the scheduler to
the schedule. With the function "Add all" you can add them to the schedule all at once.
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Actions ~~ Fewer options
Edit 5 February 2024
Schedule P Add All > Add All from Standby

| View > Add All incl. Alternatives > Add All from 5elected Production Orders
Capacity Management > Fill Idle Times Add All from 5Selected 5ales Orders
Timescale > Fill Idle Times incl. Alternatives E
Calendar p Tighten Queues i I
View Filter > Move to Standby L1021 (40) I 10§18 10104 101035 10104 180
Search > Recalculate Current Schedule

107089 TUT023 (48] 10105 1071033 109( 101043

’I i E"I .r"*lliil

Of course, this doesn't happen at random, but follows strict prioritization rules.

7.7.1. How it works

e Based on the assumption that late production orders are to be avoided, the VAPS
automatically creates a prioritized list of the production orders that are on standby,
proceeding as follows:

o calculating a buffer time per production order, following the formula:

o buffer time = [required due date] - [end date of last operation as per BC]

o starting with released production orders, then firm planned, then planned

o within each category, assigning the highest priority to production orders with the
lowest buffer, the next highest to those with the next lower buffer, etc.

e The orders are added to the schedule according to their priority

e The following settings can be made in the VAPS setup:

o define the "schedule start" date
o decide whether you want to take into account EMAD
o specify the number of iterations

7.7.2. More efficiency by planning per sales orders

Sales orders can have different priorities and planners often like to schedule them en bloc based on
these priorities. This would ensure that the next free capacity is used in the best possible way for the
corresponding sales order.

But, however, what if a sales order consists of, let's say, 40 items that on the other hand lead to 40
production orders? This is where it gets difficult because these 40 production orders are on Standby
with the other production orders.

Two according options in the "Add all" and "Add all incl. alternatives" menus offer to solve this
problem:
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Actions ~~ Fewer options
Edit >
Schedule > Add Al > Add All from Standby
N View > Acld All incl. Alternatives > Add All from Selectad Production Orders
Capacity Management > Fill Idle Times Add All from Selected Sales Orders
Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues - 10036 (30)

View Filter > Move to Standby EIN(32) 101047 (100)
Search > Recalculate Current Schedule 1010g530) 101035990

¥ 101048 (70) 1010

The options in detail:

e "Add all from selected production orders" shows a list where you can select from all
production orders where at least one operation is still on standby:

Select Production Orders to be Added 2 - 7 X
> Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder R
Add All Options
Add unplanned preced... c Do not add unplanned ... @
MNo. Description Source No. Routing No. Quantity  Starting Date-Time Ending [
- 101033 :  Prod 6 - Type 1a PO00006 PO0D0O00& 70,00 07.02.2024 09:34  01.0.3
101071 Prod 10 - type 1c PQ00010 POO0OO10 60,00 28.02.2024 22:10  07.0.
101072 Prod 19 - type 1 PO00019 P0O0D0O0O19 7500 27.02.2024 1845 07.0.
101073 Prod 20 - type 1 PO00020 PO0D0020 50,00 28.02.2024 13:55  06.0.
101074 Prod 10 - type 1c PO00010 POOCO10 100,00 27.02.2024 18:50 12.0.

e "Add all from selected sales orders" shows a list where you can select from all sales orders
with an assigned production order where at least one operation is still on Standby:
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Select Sales Orders to be Added © -+~ - 7 X

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder e

Add All Options

Add unplanned preced... Q Do not add unplanned ... @
Requested Bill-to Salesperson
Status No. Delivery Date Customer No. Bill-to Name Code
- Open :  50-000005 20.02.2024 32789456 Lovaina Contractors OF
Releazed SO-000011 08.03.2024 35122112 Bilabankinn OF
Releazed S0O-000012 13.03.2024 41597832 Mabel Scherrer AG OF
Open SO-000014 15.03.2024 21245278 Maronegaoce QF

In both dialogs, you can change the order by "Move up" and "Move down".

oo

A Move U
Use today | : der

W Move Down

+ Show as menu

7.7.3. Regulate the behavior of preceding and succeeding linked production orders

Two options allow for regulating how preceding and/or succeeding linked production orders are
treated:

e add unplanned preceding production orders first
e do not add unplanned succeeding production orders

These options can be defined as default settings via the VAPS setup:

Scheduling Parameters

Consider EMAD Max. Mumber of Sche... | 3

Add all default behavior for linked Production Orders

Default for Add unpla... m

1D Default for Do not ad... @

Consider Queue Time

808

Consider Send-Ahead

Scheduling Start (rela...
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The overview below lists all possible combinations and their respective effects.

NEVER schedule predecessors/
Max. Number of Scheduling Iterations A|WayS schedule ALL successors

Add all default behavior for linked Production Orders
Upstream prod. orders (“preceding”) do

NOT get scheduled

Downstream prod. orders (“succeeding”)
get scheduled

Always schedule ALL predecessors

Default for Add unplanned preceding ... - (@

Default for Do not add unplanned suc... - (@

Max. Number of Scheduling Iterations

Add all default behavior for linked Production Orders Upstream pI’Od. orders ("preceding") get
, scheduled
Default for Add unplanned preceding ... o " -
Downstream prod. orders (“succeeding”)
Default for Do not add unplanned suc... - (@ ) get scheduled
Max. Number of Scheduling Iterations NEVER schedule successors or
. . ) predecessors
Add all default behavior for linked Production Orders
Default for Add unplanned preceding ... C._\) Upstream prod. orders (”preceding”) do
Default for Do not add unplanned suc.. 0 NOT get scheduled

Downstream prod. orders (“succeeding”)
do NOT get scheduled
NEVER schedule successors

Max. Number of Scheduling Iterations

Add all default behavior for linked Production Orders Upstream prod. orders (”preceding”) get
Default for Add unplanned preceding ... D scheduled
Downstream prod. orders (“succeeding”)

Default for Do not add unplanned suc... D
do NOT get scheduled

However, in the "Add all" dialog, you can also spontaneously determine a deviation from the
standard specifications every time you schedule new production orders via the "add all"
function.
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Select Production Orders to be Added 2~ - 7 X

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder w

Add All Options

Add unplanned precad... m Do not add unplanned ... @
No. Description Source Mo, Routing No. Quantity  Starting Date-Time  Ending [
— 101033 . Prod 6 - Type 1a PO0O000G PO00006 70,00 07.02.202409:34 01.0.%
101071 Prod 10 - type 1c PO0QO10 PO0OO10 60,00 28.02.2024 22:10  07.0.
101072 Prod 19 - type 1 PO00019 PO00019 7500 27.02.2024 18:45  07.00
101073 Prod 20 - type 1 P0O00020 P0O00020 50,00 28.02.2024 13:55  (06.0.
101074 Prod 10 - type 1c PO00010 PO00010 100,00 27.02.2024 18:50  12.0.

All procedures described above, also apply when you want to take into account alternate
machine centers:

| Actions Fewer options
Feb: 2024
Edit > R
Wk 06 wk 07
i N Add Al 0z |04 05 o6 |07 |08 |oo [H0°9Hi 12 \
Mmoo View > Add All incl. Alternatives > Add All from Standby incl. Alternatives
Capacity Management p Fill Idle Times Add All from Selected Production Orders incl. Alternatives
Timescale > Fill Idle Times incl. Alternatives Add All from Selected 5ales Orders incl. Alternatives
Calendar > Tighten Queues :

‘II)1014 101040 (5( 101022 101046 (40) 1

View Filter > Move to Standby b 1021 (40} 104010103 104835, 101 04 180}
Search > Recalculate Current Schedule 01030 (50) 101031 (120) [§0103[(50 1010431(50)
» I i E'I 'JIII.” 101009 101023 (48) 10103 101033 109 101042 (110)

7.8.Move unhandled production orders, production order lines, or operations to
standby in one go

The VAPS allows moving unhandled production orders, production order lines, or operations back to
standby in one go.

7.8.1. Definition of “unhandled”

e Unhandled future processes that are to start after the scheduling start date. In case users
have "played around" a lot and then they may realize that they are no longer 100% satisfied
with the plan, this feature helps them to quickly replan starting from a certain date by
moving the operations to standby and then applying the "add all" function.
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e Unhandled past processes, i.e., operations the routing status of which is not “in progress” or
“finished,” meaning operations that should have started before the current work date but
haven't.

1043 (90)
142 (110) 1064 (40) ]

Unpin »

Pin with Capacity blocked * m

i . .
Pin without Capacity Consumption e a

120) o
m| Move to Standby il Move Operation to Standby

Move Prod. Order Line to Standby

|

[

Mavigation ¥

Move Production Crder to Standby
Schedule Successars

Apply Routing

Apply alternative Routing

1030 (50) Set Focus
038 (66) Remaove Focus

B

Change Prod Order Status

Apply Shop Floer Changes

Change Duration

Move Pinned/5tarted Operation

Standard MRF Behavior

@3
g 2
I

Exclude from MRP
Include into MRP

Show Additional Information » o o o o -

7.8.2. Move unhandled operations to Standby per work or machine center

Sometimes planners don’t want to move operations of the whole plan but are focusing just on a
single work or machine center and want a more granular version of this functionality.
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The context menu of the work/machine center in the capacity view offers according options:

4 Milling | Frasen

sov e ']
@

4 Gear Cutting | Ver=ohmon N

Standby (o0) Fill Idle Times on this Work Center

—

Tighten Queue on this Work Center

Move Unhandled Future Operations on this Work Center to Standby

LC 500 Mave Unhandled Past Operations on this Work Center to Standby
LC 180 Maove Operations Without Fully Promised Receipt Dates on this Work Center to Standby
Phoenix Define additional Down Time

Define additional Up Time

Standby (00} | Edit additional Down Time

Remeove additional Up Time

Sort Order

P —— {
= =
H H
— =

Wagner BAZ
Show operations overlapped in one row

TC 229 Brother

how operations stacked

My very old mill(Eff ="20%) L ! —_— —

=

7.9.Fill idle times

Typically, scheduling with finite capacities, will often lead to idle times on machine centers and of
course, for the sake of efficiency and cost cutting, everybody in planning wants to use their capacities
to the fullest extent possible. The function "Fill idle times" helps to avoid idle times on machine

centers.

7.9.1.

How it works

The VAPS automatically creates a prioritized list of the production orders that are already
assigned to machine centers, following the same strict prioritization rules as in the "Add all"
function.

All operations are tried to be moved forward to avoid idle times.

Already scheduled production orders are not getting pushed out (they are only squeezed in).
The following settings can be made in the VAPS setup

o define the "schedule start" date

o decide whether you want to take into account EMAD

o specify the number of iterations
When you start the scheduling process under "Actions -> Schedule", click the according
option to determine whether you want to take into account alternate machine centers or
not.
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Schedule View ~ Times

Add All

Add All incl. Alternate MC

1 Fill Idle Times

] Fill Idle Times incl, Alternate MC

7.9.2. Fill idle times on a single work or machine center

If you want to fill the idle times on a certain work/machine center only, select the according item

from the center's context menu.

7.10. Tighten Queues

With this feature you can minimize gaps between operations on a resource by shifting all operations
to the scheduling start position as far as possible. The function differs from "Fill idle times" in that it
does not change the order of the operations. Please note that operations before the scheduling start

will not be affected.

The picture below shows an example with operations before they were tightened:

o § & ‘B ©

i L B8 BN « o0 Ff
3 i e eEEm E@EF oW
ELN 1 @ E
And this is how it looks after tightening the operations:
O | %10 <0 Eo éaw <of R Er s
el | IpE® G mEemEEr EE
W EE L. I T
=
= NETRONIC
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You can activate this feature

e for asingle resource via context menu

Cutting #1

Fill Idle Times on this Machine Center
Cutting #2 Tighten Queue on this Machine Center
e Define additional Down Time

Define additional Up Time |

4 Drilling Edit additional Down Time

Remove additional Up Time |
Standby (o0)

Sort Order

Show operations overlapped in one row
ST Show operations stacked

e forall resources by clicking the according item in the "Schedule" menu:

MNETROMIC VAPS Open in Excel Actions Fewer options
Edit -~ Schedule View ~ Timescale ~~ View Filter -
— -
4 Machit
Add All incl. Alternatives
4 Cutti
Fill Idle Times
Stal

Fill Idle Times incl. Alternatives

Tighten Queues

Cut Maove all
Mowve Unhandled Future Operations to Standby

i Move Unhandled Past Operations to Standby

e T | Define additional Down Time |'

7.11. Calculating and working with earliest material availability

The VAPS takes into account the earliest material availability date = EMAD.

7.11.1. Material availability: Fundamentals

Without any further specification, the VAPS calculates the EMAD just on production order line level.
Hence, there is no EMAD per operation at all. You can, however, have the VAPS also consider routing
links so that the EMAD can be calculated by the production order routing line which means that a
production order line can be started even when the material for one (or more) operations is not yet
available. ¢ We calculate a value that we call EMAD = earliest material availability date

7.11.2. Basics of the EMAD calculation

e We create a unique list of component demand day by day
e  We take into account
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Demand from production orders
Demand from sales orders
Demand from transfer lines
Demand from job planning lines
Demand from service lines
o Demand from assembly orders
e Then we create a unique list of component supply day by day
e We take into account

O O O O O

o Supply on inventory

o Supply from purchase orders
o Supply from production orders
o etc.

e Then we allocate component supply to component demand

7.11.3. How we allocate

e First we remove any reservations because reserved components will never get allocated
e Then, day by day, we allocate an available component to a component demand
e You can define the priority which demand to supply first

Example: sales orders first, then production orders, then transfer orders

€ EMAD DEMAND PRIORITY | WORK DATE: 1/28/2021 NOT SAVED 0 o= A2
| o ) —
| M Search -+ New B Edit List Il Delete ﬂﬂ Open in Excel =
Priority Document Type T
1 Sales Line
2 Prod. Order Component
= 3 Sales Line v

Sales Line

Service Line

Job Planning Line

Prod. Order Component
Assembly Component
Transfer Litte

e If there is enough component supply on a certain day, we allocate that supply to the component
line, and have an earliest material availability date for that component.
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Su PP'V Monday Tuesday  Wednesday Thursday Friday
Component 1 100 500 300 50 600

Demand Monday Tuesday Wednesday Thursday Friday
Component 1 50 600 300 250 601

Allocation Monday Tuesday Wednesday Thursday Friday

Component 1 YES (50) NO YES (300) NO NO

EMAD Monday Tuesday Wednesday Thursday Friday

Component 1 Monday none Wednesday none none
7.11.4, Setting the EMAD

A production order typically requires multiple components. If all components are available in the
look ahead window timeframe, each component line gets an EMAD. We take the latest EMAD of all
component lines as the EMAD for the production order. Example:

e Production order 1
o Component 1 - EMAD = December 1
o Component 2 - EMAD = November 20
o Component 3 - EMAD = December 4
e EMAD for production order 1 = December 4

7.11.5. Consider the EMAD on the production order routing line level

Without any further specification, the VAPS calculates the EMAD on production order line level with
no EMAD per operation at all. You can, however, have the VAPS also consider routing links so that
the EMAD can be calculated by the production order routing line which means that a production
order line can be started even when the material for one (or more) operations is not yet available.

Let's assume you have three operations. Let's also assume that this requires a very expensive raw
material, but only at the third. Hence, you want that expensive material to be there only when you
plan that third operation to start. In other words: you can start the first two operations without that
precious raw material available. If you assign that particular raw material to the third operation via a
routing link, you now get EMAD information as follows (on the production order routing line level):

Earliest
Materia
Operation Earliest Start Availability

Ng. t Type No. Description Alternate Routing Set Date Date

— 10 IIlMachine Ce... 110 Drilling | Bohren #1 28.01.2021
20 Machine Ce... |210 Milling | Frase #1 28.01.2021
30 Machine Ce... 410 Welding | SchweiBen #1 16.02.2021
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Per default, after having calculated the EMAD allocation, the VAPS would schedule all three
operations starting after the EMAD of the latest operation. For the sake of clarity, | switched on the
Availability View where you see operations with available material in green, the ones with
unavailable material in red:

MNETRONIC VAPS Open in Excel Actions Fewer options

bruary 2021

Capacities k 06

4 Machining | Fertigung

4 Drilling | Bohren 4
Standby (o)
Drilling | Bohren #1 »
Drilling | Bohren #2 »
4 Milling & Turning | Frasen & Drehen )
Standby (e0)
Milling | Frase #1 » 007, [ 4
Milling | Frése #2 b
Turning | Drehen #1 4
Milling & Turning | Frasen & Drehen b
4 Sawing | Sagen b
Standby (o)
Saw | Sige #1 »
4 Welding | SchweiBen b
Standby (o0)

Welding | SchweiBen #1 » ' l

As stated above, you can instruct the VAPS to consider the routing links. This is done on the VAPS
Setup page:

Material Availability

Look Ahead Window 12W Exclude None-Invent...

Use Routing Links Exclude Blocked Inve...

Further steps needed:

e Create the desired routing link code

= Routing Links | Work Date: 28.01.2021
L Search + New  EREditList  [i] Delete  EE Open in Excel
Code Description
100 Assembling
200 CNC/Axle
300 Inspection
- 999 : EMAD example
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e Enter this routing link code on the according routing page and in the BOM

o

Routing:
Lines Manage More options
Previ... Next
Operation Oper... Opera... AlternateRou... Routing Link
No. t No. No. Typs Ne. Description Set Code
- 10 20 Machine Ce... 110 Drilling | Bohren #1
20 10 30 Machine Ce... | 210 Milling | Frase #1
30 20 Machine Ce... 410 Welding | Schweifen #1 999
Lines Manage  More options B
Type No. Description Quantity per  Unit of Measure Code Serap%  Routing Link Code
- |ltem 70073 Teil 1 - EMAD Routing Link Test 1 PCS 0
Itam 70074 Teil 2 - EMAD Routing Link Test 1 PCS 0
Item 70075 Teil 3 - EMAD Routing Link Test 1 PCS 0
Item 70076 Teil 4 - EMAD Routing Link Test 1 PCs 0 998

As a result, two of your operations start at their earlier EMAD, the last one at its own, later EMAD,
this, of course, saving you time in your production processes.

NETRONIC VAPS

Capacities

4 Drilling | Bohren
Standby (o0)

Standby (o0}
Milling | Frase #1

Milling | Frase #2

4 Sawing | Sdgen
Standby (o0)
Saw | Sdge #1

Standby (o0}

4 Machining | Fertigung

Drilling | Bohren #1

Drilling | Bohren #2
4 Milling & Turning | Frasen & Drehen

Turning | Drehen #1

4 Welding | SchweiBen

Open in Excel

Milling & Turning | Frasen & Drehen

Welding | SchweiBen #1

Actions

-

- v v v

Fewer options

Eﬂuary 2021
k 04

26 (27 |28 |29

Lling Start

L]

February 2021
Wk 05

0072

End of Frozen Perjod
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In the Availability View, the VAPS even provides an optical warning, if you drag an operation to a
point of time that is before its EMAD by showing the according operation in red:

NETRONIC VAPS Open in Excel Actions Fewer options
Rnuary 2021 February 2021
Capacities k 04 Wk 05
26 (27 28 29 30 31 01 02 03 04 10
4 Machining | Fertigung £ E
4 Drilling | Bohren » ‘3\ o
Standby (e0) & 7
Drilling | Bohren #1 » 2 2
g
Drilling | Bohren #2 » o
4 Milling & Turning | Frasen & Drehen » w3
Standby (o0)
Milling | Frése #1 » 0072

Milling | Frase #2

Turning | Drehen #1

Milling & Turning | Frasen & Drehen
4 Sawing | S3gen

Standby (o0)

Saw | Sage #1 > |

4 Welding | Schweiien »
Standby (oo)
Welding | SchweiBen #1 » —ﬂ

Tip: If you work with routing link codes you should define priorities in the dialogs "EMAD demand
priority" and "Routing demand priority".

7.11.6. Exclude items from EMAD calculation

In the current EMAD calculation logic, “all” components of a production order are considered when
calculating the availability date.

With very detailed BOMs and having even low priority material in these BOMs (meaning material
which could be replenished very easily e.g., by a local dealer around the corner), this could create
some downsides:

e material that is out of stock but could easily be replenished might render a production order
as “unable to allocate”

e all these materials need to be calculated, although they won’t be a blocker for the
production process

Because of this, you can exclude certain items from the EMAD calculation by ticking the option
“Exclude from EMAD (VAPS)” on the item card and related pages. You can also exclude complete
item categories from EMAD, by ticking the option on the respective category card. In this case, the
setting is passed on to all associated articles and does not have to be made separately for each
article.
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N
1000 - Bicycle
Process Item Prices & Discounts Request Approval More options
ltem Show more
Ne. |m Show in VJS @ >
Description Bicycle Item Category Code o
Blocked ® ) Caler (VAPS) #911d1d
Type Inventory v Exclude from EMAD (VAPS) @
Base Unit of Measure PCS s
7.11.7. Consideration of the supplier's delivery date promises in planning

In times of uncertain supply chains, information about material availability has become more and
more important. When parts are ordered, it is important to know whether the supplier has
confirmed a delivery date and what that date is. Production planners need to know for which
production order lines (still to be planned) there are unconfirmed required materials. What is more,
they only want to specifically schedule the production order lines for which the supplier has
confirmed a specific date. We have taken care of these planning requirements and implemented a
new functionality.

The "VAPS Setup" dialog offers a new option that allows to exclude production orders without a
promised delivery date from the planning with "Add all" and "Add all incl. alternatives":

Material Availability

Look Ahead Window 12W Exclude Blocked Inve.. - (D

Use Routing Links m Exclude Mot Fully Pro... m
Exclude Mone-Invent... m Include Fully Consum... m

Please note that you can still plan these orders manually per drag and drop.
Handling of operations without promised receipt date that are already allocated

In case operations of a production order with missing promised receipt date are already allocated to
resources, they can be made directly visible. For this, we have added a new option to the "Availability
View". Now operations needing material that is not fully promised are shown in orange (default).
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Actions ~ Fewer options
Edit >
Schedule >

] View >

Capacity Management >

Timescale

Calendar

View Filter

Search

ferzahnen

y 2024

@ Enable Focus Mode
@ Disab

@ Show Setup Times

e Foc

iQ Hide Setup Times (50) 10#086 (30) 1010 m
& Hid o 101080150 10104940)

18, View Color Mode > 8 Item View

Use short menu ¥ Machine/Work Centre View

101048)70) 101( .

| B8 5ales Order View | 101 m
- 29 Broduction Order View - 1101101036 (80) 10101048 (70) 10104710804 101

T3

(DL -1§] I Prod. Order View D45 (32'101039)28) 1010§880) 1010/ 103064 (101047

Prod. Order Status View 101044 (50) 1014

100043 (70

! [0 Progress View
" [ Shop Floor Status View

B2 Availability View

5‘5‘,‘ Wait Times View Sets the mode to the availabili ” 101047 (100) 101! 108
B rre view _ 1011048 (70) 10049 (. 101¢

You can change the default color in the VAPS setup:

| Actions ~~
Edit
Schedule

en View

Fewer options

Capacity Management

Timescale

Calendar

View Filter

Search

»

4

>

2024 February 2024 LA~ J
Wk 06
o1 |02 [03°9]64 05 |06 |07 |os |oo |70

Add All

Add All incl. Alternatives >

Fill Idle Times

Scheduling

Fill Idle Times incl. Alternatives

Tighten Queues

1 0 (50101 1046 (40)
Move to Standby > Move Unhandled Future Operations to Standby |
Recalculate Current Schedule Move Unhandled Past Operations to Standby l_

0

Move Operations Without Fully Promised Receipt Dates to Standby

_ [ o el il

The planner can move these operations back to Standby by an according menu item:
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Actions ~~ Fewer options
Febi 2024
Edit > e <
Wk 06
Schedule > Add Al [o4 o5 los [o7 |os o9 [F0 4
en View > Add All incl. Alternatives > =
| - E
=
Capacity Management > Fill Idle Times =
5
Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues
View Filter > Move to Standby > Move Unhandled Future Operations to Standby |
Search > Recalculate Current Schedule Move Unhandled Past Operations to Standby )_

\ » TOTTUTOT
I u_T Move Operations Without Fully Promised Receipt Dates to Standby =
More options to exclude/include certain items from EMAD calculation can be found on the Setup
page.

7.11.8. Handling of operations with missed EMAD

The picture below shows a production order that is scheduled to start on the 14th (of February)

101044 (60} 1010610111
10104 101047 (100)
107105101045 101036 (80)

101048 (70) 101082 30)

101066 (75

10107107102101010311017 101048 (70) 10711011C

10101021010 101039 (28) 1010303 10710101047 101074

However, when you have a look at the EMAD calculation, you'll see that the earliest availability date
is the 16th.

Earkest

Matedal
Reserved  Manning Unit of Sales Order Sales Ordes Avadlability
Itern No. Starting Date-Time Ending Date-Time Quant.. Quantity  Flexibility Measure Code Ne. LineNo. Date
= P000014 £§ ' 14022024 1840  01.03.2024 08:30 40 40 None PCS SO-000006 10000 16022024

The VAPS provides a helpful feature in the "Schedule" menu that allows you to easily move any
production orders that violate their earliest material availability date back to standby. This ensures
that your production process stays on track and avoids any delays caused by unavailable materials.
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Actions Fewer options
uary 2024
Edit 06
Schedule > Add All
e View > Add All incl. Alternatives i !
1 10 i
Capacity Management > Fill Idle Times " |
e 101044 (60§ 1010610111 o)
Timescale Fill Idle Times incl. Alternatives ' 10104 101047 (100) ;
Calendar Tighten Queues 1010510104¢ 101036 {80)
View Filter Move ta Standby ' Move Unhandled Future Operations to Standby
n
Search Recalculate Current Schedule Move Unhandled Past Operations to Standby
’ 1010°11010:1€1016101031,(120) Move Operations Without Fully Promised Receipt Dates to Standby ﬂ

Verzahnen »

aneleperahons With a Missed EMAD to Standby

7.11.9. Handling of completely picked items

Completely picked (i.e., taken from inventory) items are treated with a higher priority than unpicked
ones

7.11.10. Apply EMAD tolerance to an item

As is commonly known, the EMAD calculation provides a date from which the required quantity of
component demand is available and before which the production order must not start. The newly
implemented EMAD tolerance allows defining the criterion not too narrowly so that, e.g., an order
could already start if only 95% of the required material is available.

To be able to do so, we have enhanced the item card with the respective setting option. When
calculating the demand, the entered value is multiplied by the available quantity.

1001 - Touring Bicycle

Process Item Prices & Discounts Request Approval More options

Item Show more

No. [1001 I[-]  showinvis @

Description ‘Touring Bicycle | Item Category Code | v ‘

Blocked @ Color (VAPS) | -

Type ‘ Inventory V| | EMAD Tolerance Percentage | 5,00 ‘|
Base Unit of Measure ‘ PCS v | Exclude from EMAD (VAPS) @

7.11.11. Shortcut to EMAD demand entries

We enhanced the Item card so that you can directly navigate to the EMAD demand entries.
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N
€ Item Card | Werk Date: 28,01.2021 (&) -+ T
NS
1000 - Bicycle
Process ltem Prices & Discounts Request Approval Actions Related Fewer options
€ History ~ [tem -~ 5’,—“. Availability ~ EZ-} Purchases 1l= Sales - B8 Bill of Materials ~ = Warehouse % Service @R
@ ltems by Location
No. ses Item Category Code e
B3 ltem Availability by >
Description Service ltem Group o
Statistics o7
Blocked Automatic Ext. Texts @
"8 EMAD Demand
Type | mvstony v Commann ltem Me
Show Demand Entries calculated from Earliest Material Availability Date process. |
Baze Unit of Measure PCS s Purchasing Cede e
Show in VJS ® Color (VAPS) #0cf151
Last Date Modified 08.11.2019 EMAD Tolerance Percentage 0.00
GTIN Exclude from EMAD (VAPS) -~ @

7.11.12. Run EMAD calculation from Job Queue

With the help of the Business Central job queue, you can schedule certain background jobs for
regular execution. The EMAD calculation, which until now could only be called via the VAPS
(interactively with - depending on the data volume - long calculation times), can now be triggered via
the job queue as soon as the VAPS is installed. Thus, it could be run at night, for example, without
supervision and without the need for someone to log on to the system to start the VAPS.

Setting up the job queue has to be done within Business Central by the administrator.

7.12. Resolve conflicts due to overloads or link constraints

It goes without saying that planners want - and need - to work with a schedule free from obvious
conflicts such as sequence conflicts and overloads. On the other hand, due to the complex structure
of Business Central data, production simulations, and updating the simulations with changed
Business Central data, these conflicts cannot be fully avoided.

We solved this problem with the function "Recalculate current schedule":
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NETRONIC VAPS Actions

Capacities ks
Schedule
4 Production |
4 Turning | Drehen
Standby (eo)

View

Capacity Management

CTX400
CTX 2500 Timescale
Beta 500 Calendar

Beta 800 i i
View Filter

4 Sawing | Sdgen

Standby (o) Search
Saw | Sage

4 Gear Cutting | Verzahnen
Standby (eo)

LC 500
LC 180
Phoenix

4 Milling | Frasen
Standby (o)

Wagner BAZ
TC 229 Brother

This function ensures that

v v v v

i

(66) (10104 101043 (90) "1( (10

Fewer options

Sy 2024
Add All
Add All incl. Alternatives
Fill Idle Times
Fill Idle Times incl. Alternatives

Tighten Queues

Move Unhandled Future Operations to Standby

Move Unhandled Past Operations to Standby

Recalculate Current Schedule

(€1010°101042 (110) " 1010:

|
101143 (

(7 (10110103101034 (4 1010:4101°1

|

101149 (75)
10tii0;

March 2024

Wk 10

011010101155 (¢

1014¢

10

101101

@y

]Wkﬂ

101 1

101 /10

a8 foi

e the schedule will be literally "cleaned up" so that there will be no more sequence conflicts

and overloads

e no operation will be pushed to the left - the earliest start date for each operation is the start
date as of the current simulation

It can be very helpful after

e updating the schedule with shopfloor data
e changing the work/machine center capacity settings

8. Simulations

8.1.What is this simulation idea all about?

The Visual Advanced Production Scheduler does not just support one version of the schedule. You

can create multiple simulations and scenarios, then compare them, and then publish the one that

fulfills your purpose best.

Simulations are somewhat a cornerstone of the Visual Advanced Production Scheduler. In essence,

the idea is as follows:

1. You can create a snapshot of the current production schedule.
2. This snapshot is saved as a copy of the production schedule. That way, your Dynamics 365

Business Central database does not get impacted.

3. You then can work with that snapshot (i.e., that copy) and check how certain changes to your
schedule would impact your entire production schedule.

4. You can take as many snapshots as you like. Hence, you can build as many schedule scenarios

as you need.
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6.

If you have a simulation/ scenario that you want to use as a new production schedule going
forward, you can publish it. That way, your Dynamics 365 Business Central database gets
updated.

As long as you do not publish, the Business Central database does not get changed.

Some additional facts that are important to know:

You can view each simulation both in tabular form and as a visual planning board,
You can use the visual schedule to make drag & drop changes to a simulation.
Any change that you do to a simulation gets automatically saved in the simulation table.

8.2.How does the production simulations page work?

We have our own page to manage simulations. It is called "production simulations". Here, you can
create, change and publish simulations.

You can access the "production simulations" page from the NETRONIC VAPS menu, or by simply
searching for "production simulations". The production simulations page looks as follows:

VAPS Demo 3 {s Sales & Purchases Journals Worksheets Product Design Capacities Setup & Extensions NETRONIC VAPS - > =
Simulations: Al O Search  [i] Delete B EditList D EMAD Allocations  [R Create Simulation 53] View Simulation B Update Simulation -+ Y = ® /[
£ Publish Simulation

Description Default View Color Type :fd:?;?ﬂt Inva..  Out.. Creator 2 Compare Simulations Basefilter ID Datafilter ID
) Created on 13.10.22 19:14 ! Prod. Order Status 36 ADMIN B view simulation Data 1 0
Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN 5 Copy Simulation 1 0
Copy of Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN EE Open in Excel 1 0
Simulation Created on 02.11.22 10:35 Prod. Order Status 37 ADMIN More options 2 1
Simulation Created on 02.11.22 10:36 Prod. Order Status 1 ADMIN 02.11.2022 10:37 2 2
Simulation Created on 02.11.22 10:39 Prod. Order Status 1 ADMIN 02.11.2022 10:39 2 2
Simulation Created on 02.11.22 13:35 Prod. Order Status 1 ADMIN 02.11.2022 13:35 2 2
Simulation Created on 02.11.22 14:28 Prod. Order Status 1 ADMIN 02.11.2022 14:28 2 2
Simulation Created on 03.11.22 16:30 Prod. Order Status 37 ADMIN 03.11.2022 16:31 3 1
Copy of Simulation Created on 02.11.22 14:28 Prod. Order Status 1 ADMIN 07.11.2022 11:27 2 2
Simulation Created on 07.11.22 11:29 Prod. Order Status 1 ADMIN 07.11.2022 11:29 3 2

As you can see, this page consists of certain functions and a specific table. Let's have a look at both
separately.

8.2.1.

Functions of the simulations page

The following functions are available on the "production simulations" page:

Search: The search field starts a dynamic search within the description column of the
simulations overview table below. The list of simulations is automatically adapted while you
type in your search term.

Delete: You can delete the selected simulation. You can also select multiple simulations
(press edit list first) and then delete them in one go. Please note you cannot undo a
deletion..

Edit list: This is standard Dynamics 365 Business Central functionality and allows you to edit
the list below

EMAD Allocations: Opens the EMAD — calculate allocations” page

éﬂllz' N ETRONIC pace 134 oF 152



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

8.2.2.

Create a simulation: Create a new simulation that is based on certain criteria such as
timeframe and production order status. Here is more detailed information about how to
create a simulation.

View simulation: Select a simulation in the table below and click "view simulation" to open
the visual schedule in which you can manage your production simulation via drag & drop.
Update simulation: You can update a simulation here or also directly in the planning board.
If you select more than one simulation, all selected simulations will be updated.

Publish simulation: Select a simulation from the table below and publish it. A publish
updates the underlying Dynamics 365 Business Central database. Once published, the
respective simulation is removed from this table on the "production simulations" page.
Compare simulations: You can compare different simulations and decide which one suits you
best.

View simulation data: With "view simulation data" you open a tabular view of all data that
are part of the selected simulation.

Copy simulation: If you want to create a new simulation that has lots of settings in common
with an older one, just copy this simulation.

Filter: Click on the filter icon ?to define and apply a filter to the table below.

Layout options
in form of tiles.

: You can choose whether to show your overview of simulations as list or

Notes ©: by clicking this icon in the menu ribbon, you open a small window where you can
add, edit, and delete notes for a specific simulation to provide additional information.

Content of the simulations overview table

Description: You can name a simulation with any description that you want. You can do this
when you create the simulation. Or you can just click on a table cell in the "description"
column and type in any name for that specific simulation. If you do not give a description on
your own, the VAPS will determine one (like in the above table, where it says, "Simulation
No. 0 on 07/22/19".

Default view color type: Select the color scheme (see separate article on color schemes) that
you want to apply when you view the simulation.

Created on: Date on which this specific simulation was created.

Production order lines count: Number of production orders that are included in this specific
simulation.

Production routing lines count: Number of production order routing lines that are included
in this specific simulation.

8.3.How do | create a new simulation?

We have our own page to manage your simulations. It is called "production simulations". Here, you
can create a simulation by applying various criteria.

You can create as many simulations as you like. Each simulation is a snapshot of your current
schedule, which you then can change via drag & drop in the visual scheduler. We keep each
simulation persistent as long as you either publish or delete it.
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You can create a new simulation on the "production simulations" page, which you can access from
the NETRONIC VAPS menu, or by simply searching for "production simulations". The production
simulations page looks as follows:

Simulations:  All -~ ‘ D Search [il Delete B Edit List EEMAD Allocations @Creale Simulation EJV\EW imulation %Update i ion Y = O /S D
Show
Bas...
Production Filter
Description Default View Color Type Order Count  Inva..  Out. Creator Created On 't Dial... Basefilter ID) Datafilter ID
Simulation Created on 13.10.22 19:14 Prod. Order Status 36 ADMIN 13.10.2022 19:14 1 0
Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN 13.10.2022 20:18 1 0
Copy of Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN 27.10.2022 17:55 1 0
Simulation Created on 02.11.22 10:35 Prod. Order Status 37 ADMIN 02.11.2022 10:36 2 1
Simulation Created on 02.11.22 10:36 Prod. Order Status 1 ADMIN 02.11.2022 10:37 2 2
Simulation Created on 02.11.22 10:39 Prod. Order Status 1 ADMIN 02.11.2022 10:39 2 2
B n H H " .
If you click "create simulation", a new page opens:
Create Simulation 2~ X
Use default values from ‘ Last used options and filters ~ ‘
Filters
Description ‘ Simulation Created on 15.11.22 15:44 ‘
Minimum Status ‘ Planned V‘
Earliest/Latest Date Input Type ‘ Relative Date V‘
Earliest Date Formula ‘—‘IW ‘
Latest Date Formula ‘ ow ‘
Earliest Date 21.01.2021
Latest Date 08.04.2021
Default View Color Type ‘ Prod. Order Status V‘
Data Filter
No. ‘ 2 v ‘
Name One prod order
o

With this page, you define - in the filters section - certain criteria that should get applied for your
simulation.

By clicking OK, a new simulation is created.

8.3.1. The Filter settings

e  Minimum status: Define which status the production orders included in the simulation shall
have. Minimum status "planned" as in the picture above means that this simulation includes
all production orders with the status planned, firm planned and released.

Minimum Status Planned hd

Earliest/Latest Date Input Type Firm Planned

Eeleased

Earlimct Dista Carmaala 1
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e Time range for the simulation: In the time fields relating to earliest/latest date you can
specify either absolute or relative data.
We recommend working with relative date settings.
Please note that if you select "relative date", the absolute date fields get updated
automatically!

. Earliest/Latest Date Input Type Felative Date A

) Absolute Date
" Earliest Date Formula Relative Date

e Absolute time range: If you select "Absolute Date", you enter the desired dates in the
according fields:

Earliest Date 1/20/2021

Latest Date 6/30/2021

In the picture above, the simulation (remember this is the snapshot of your overall schedule that you
then want to work with) includes all production orders with the minimum production order status
"planned that start on or after 20 January 2021 and finish on or before 30 June 2021.

e Relative time range: If you select "Relative date", you have to enter an according data
formula. In the picture below, we look four days back and three months into the future:

Earliest Date Formula 4D

Latest Date Formula M

o Default view color type: Select the default color type for this simulation

Default View Coler Type Pred. Order Status hd
. Item View

Data Filter Machine/Werk Centre View

No.

Progress

Ayailability

Wit Times

Production Order View

MRP View

Name

e Data filter
The settings in this area allow you to load only data that you really need (e.g., if you only
need to work with data from your department). This means that these filter settings work as
a Dynamics 365 BC data filter on loading the data into the simulation. Data filters are already
effective at the data interface to make sure that only filtered data are handed over from
Dynamics 365 BC to the VAPS. You create and edit filters as is described below under “Base
view filter.”
Read more about using data filters in this chapter
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VAPS Data Filter 7 X

Filter: Work Center Group

* Code |E v|

* Mame | |

-+ Filter...

Filter totals by:

-+ Filter...

Filter: Work Center

* No. | v|

* Name | |

-+ Filter...

“ Ca " cel

e Base view filter
A base view filter is assigned to a simulation. This means that by opening the according
simulation, the settings of the base filter come into play in addition to the data filter, but in
contrast to the data filter, the data filtered out by the base filter are nevertheless taken into
account for the planning. Please note that the settings of the base filter cannot be changed
while the simulation is running.
A base filter can be created directly upon creating a new simulation or via the simulations

page
Decide whether the base view filter dialog pops up at the start of the simulation
Select an existing filter from the drop drown list
Create a new one by clicking "Select from full list". For details, please see the
description below on "How to define regularly used filters".
BaseView Filter
Show BaseView Filter Dialog on Start ®
Na.
e No. t Name
> 1 Show All
Filter: Production Order 2 Machining |
* Now -
+ New Select from full list
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8.3.2. How to define regularly used base view and production order filters

If you have filters that you want to apply multiple times, it makes sense to define them once. In order
to do so, click the downward-facing triangle in the dropdown menu under "saved settings" and then

click "select from full

Saved Settings

list".

EDIT - CREATE SIMULATION /'

Data

Use default values from:

Filters

Changes to the options and filters below will be saved only to: 'Last used options and filters' JER LINES

v/ SAVED

Y

PROD. ROUTING L

Minimum Status

O Search E% Edit List

SELECT - REPORT SETTINGS

NAME

Last used options and filter

COUNT Cl
Last used options and filters v ‘ BB
NAME
Last used options and fiIt(Lrs‘
Released March
Select from full list
A new page opens, from where you can manage (i.e., create, edit, and delete) all your filters:
[i] Delete % New @ Copy Edit  Show Attached x| Open in Excel
SH...
WITH
REPORTID ASSIGNED ALL COMPANY NAME
¥ REPORT NAME TOY CREATED BY us.. h 4
5526150 Create Simulation ADMIN ADMIN CRONUS Internati...
5526150  Create Simulation ADMIN ADMIN CRONUS Internati...

Released March

Ca“cel

When you click "new", you can create a new filter with certain criteria. Here is how the "Released
March" filter was defined:
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EDIT - CREATE SIMULATION

Filters

Minimum Status Released v
Earliest Date 3/1/2021
Latest Date 3/31/2021

Once defined, you can also apply this filter if you create a new simulation:

EDIT - CREATE SIMULATION

Saved Settings

4

Changes to the options and filters below will be saved only to: 'Last used options and filters’

Use default values from: Released March s
Filters

Minimum Status Released v
Earliest Date 3/1/2021
Latest Date 3/31/2021

OK

Cancel

8.4.How changes to a simulation are managed

While working in a simulation, multiple changes can happen that are treated in different ways
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8.4.1. General changes to production orders

General changes to production orders while there are simulations (opened or not opened) that do
not include these production orders are

e add new production orders

e delete production orders

e change "general" production order data, like
o duedate

required due date

color

quantity

setup time for one routing line etc.

o O O O

Effects of general changes
e the simulation gets outdated
e you get a notification if this happens while a simulation is open
e you can directly update the simulation

Edit ~~ Schedule - View

Undo

Redo

| 28 Update Simulation
Schedule successors
Apply standard Routing
Apply alternative Routing

X Exit discarding changes
Cutting #2

8.4.2. A specific change to a production order: the status change

Changing the production order status can lead to a change of the production order ID, this making
the handling of simulations rather tough.

Impacts of changing the production order status

e |f you change the production order status from within the VAPS, we will seamlessly update
the open (and all other simulations)
e If you change the production order status from another session/as another user
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o all not opened simulations get silently updated

o in the open simulation: if you made a schedule change to the production order and
somebody else changed the status while you did so, you will not be able to save your
changes because the production order ID got changed.

8.4.3. A change to the production order routing line status

Changes to the production order routing line status can happen if

e somebody starts posting output/consumption on an operation from a released production
order
e somebody finishes an operation from a released production order

Impacts of changing the production order routing line status

e the simulation silently updates

8.5.Compare simulations

With version 1.3 of the VAPS we introduced a (first) set of KPIs so that you can compare different
simulations and decide which suits you best.

Click "Compare Simulations" on the simulations page:

'i_:!] View Simulation Data

= Compare Simulatio@

Creater

HE Cpen in Excel
&/30/

Actions
&/30/

6/30/, Fewer options

The “Simulations KPI1” pages opens up:
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. ( j\- 4 [l ./ SAVED = S
Simulations KPI

4l Previous Set > Next Set =% Refresh KPls e Setup

Options

Show Code (. ) Last Update Date-Time 9/30/2020 2:34 PM

Simulation KPI Matrix Manage =1

Ne. Ops. on Neo. Late Prod ot;
Description MNo. Prod. Orders Standby Orders

= Simulation Created on 07/06,/20 02:45 PM

Simulation Created on 09/15/20 11:22 AM

LI ST

Simulation Created on 09/17,/20 11:40 AM

Simulation Created on 09/30,/20 02:34 PM 2

—
B
P

Simulation Created on 09/30/20 02:35 PM

This page shows the following KPIs per simulation:

e Number of production orders

e Number of operations on standby

e Number of late production orders

e Total delay (hours)

e Total setup time

e Total buffer time (time between end of production order and required due date)
e Number of production orders without required due date

On the "Simulations KPI" page you can

o refresh the KPIs: if you have added a new simulation, the KPIs of this simulation remain
empty until you have refreshed them

e call the "KPI Setup" dialog, where you can exclude/include outdated simulations from/in your
comparison

e call another dialog via Setup-->Navigate-->Measures where you can administrate your KPIs
(delete, hide, change order)

= NETRONIC

pace 143 or 152



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

— SIMULATION KPI MEASURES | WORK DATE: 1/28/2021 ~SAVED =

O Search - New B Edit List i| Delete @8 Open in Excel

2N0OW In

Code T Description Caption Sequence Martrix

> ! Number of Late Production Orders No. Late Prod. Orders 3
NO UDATE Number of Prod. Orders missing ... No. Prod. Orders Missing Due Date 8
NUMPRODORD Number of Production Orders No. Prod. Orders 1
STANDBYOPS MNumber of Standby Operations Mo, Ops. on Standby 2
TOTALBUFFER Total Buffer Time Total Buffer Time (hours) 7
TOTALDELAY Total Hours Delay Total Delay (hours) 4
TOTALSETUP Total Setup Time Total Setup Time (hours) 6

8.6.How do | publish a simulation?

We have our own page to manage your simulations. It is called "production simulations". From here,
you can publish a simulation. "Publish" means that we update the underlying Dynamics 365 Business
Central database.

You can publish a simulation from the "production simulations" page, which you can access from the
NETRONIC VAPS menu, or by simply searching for "production simulations". The production
simulations page looks as follows:

| &  PRODUCTION SIMULATIONS | WORK DATE: 1/28/2021 ~/ SAVED A4
O Search B Edit List lil Delete [® Create Simulation % Publish Simulation 5l view Simulation 5] View Simulation Data  --+ Y =
| DEFAULT VIEW PROD. ORDER LINES PROD. ROUTING LINES
DESCRIPTION COLOUR TYPE CREATED ON COUNT COUNT
Simulation No. 0 on 07/22/19 Prod. Order Status 7/22/2019 10:40 AM 23 131
Released production orders - 07/22/19 i ltem View 7/22/2019 11:48 AM 6 42

If you click "publish simulation", the selected simulation gets published. Once it is published, it gets
automatically deleted and removed from the above-shown table.

Please remember: "publish" means that we update the Dynamics 365 Business Central
database. "Publish" means that the simulation becomes your new production schedule.

8.7.Handling of simulations with warehouse activity lines

When a production order contains a warehouse activity line, the order cannot be modified, and the
associated simulation cannot be published. To provide more meaningful user information in these
cases than the generic error message from Business Central, the VAPS offers the following support:

e asymbol for blocked production order routing lines
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e aninfo window telling the users which production orders have been blocked

The following changed Production Orders have blocking
Warehouse Activity Lines that need to be handled before

publishing the simulation:
Released: 101006

Released: 101007

Since checking for affected production orders could consume excessive time in environments with a
high volume of orders, the "Disable Warehouse Activity Line Check" option in the "General" section
of the VAPS setup dialog allows for disabling the checking process. Please note, however, that in this
case, the affected orders will still be blocked from modification.

General

Hide Links between F...

Include Operations o...

Progress Calculation

8¢

| Based on Quantity

A

Disable Warehouse A...

= NETRONIC

Show Infosymbol on Additional Information

Show Symbel on Co...
Show Symbol on Tool...
Show Symbel on Pers...

Show Symbal on Qlty...

008
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9. Day-to-day use cases

9.1.Working with subcontracting work centers

The VAPS supports setting up and visualizing subcontract work centers

Many manufacturers seem to use the subcontracting functionality of Dynamics 365 Business Central
which implies setting up a work center as a subcontract work center. In general, two major use cases
can be differentiated:

1. Subcontractor as standard operation

In some cases, manufacturers need to outsource certain steps of their production process,
because they don't have the needed machines. In this case, they set up a routing and have a
subcontracting work center (which equals their supplier) as usual step of this routing.

Subcontractor as option to deal with bottlenecks

In this case, manufacturing companies do everything on their own. But there might be cases
in which they want to outsource something to a subcontractor because all their machines are
busy. In that case, their standard routing is on their own machines, but they can change it
manually so that then they send one operation to a subcontractor.

Since working with subcontractors is a really fundamental functionality for manufacturers, the VAPS
enables visualizing and handling subcontractors as follows:

Subcontract work centers are treated as work centers with infinite capacities because
capacities and availability of the subcontractors are unknown to us.

Subcontract work centers can be made part of alternate routing sets (although the rest of
the VAPS currently still focuses machine centers when scheduling).

(J / SAVED

Alternate Routing Set

Show Attached

Header

No.

Version No.

Description Blocked

Alty

ernate Routing Lines

SETUP TIME RUN TIME
TYPE CENTER NO. MACHINE CENTER NAME MULTIPLIER MULTIPLIER
i 1.00 1.00
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After having set up a subcontractor work center, operations can be assigned just the same as is done
with "normal" work centers. However, please note that there is no Standby machine center.

Capacities

Standby (o) =
ia
- o
Milling #1 g=
=
o
. )
Milling #2 ﬁ
Turning #1
Milling & Turning l

Subcontractor 1 [ 3 01033 01023

4 Assembly & QC

The default color of the subcontract work centers can be set in the "Color Setup":

Workcenter

Subcontract Workcenter Color #00a0a0

9.1.1. Handling of subcontractor production orders with related purchase orders

If a purchase order mirrors a certain production order (and is used for communication with the
subcontractor/vendor), the due date from the subcontractor production order is used for EMAD
calculation. The reasons for this are as follows:

in this constellation, the purchase order has no quantity (and hence cannot be used for EMAD
calculation).

There is also no reservation/tracking between the purchase order and the production order.

9.2.Infinite capacity for work centers/machine centers

This feature is helpful for customers who have, e.g., certain clearly defined bottleneck areas in which
it is imperative to plan with limited capacity and other areas in which it is perfectly possible to plan
with unlimited capacity.

Moreover, in cases of orders being late, this feature helps to find out more easily where the
bottleneck is, based on the overload that has occurred (when setting a machine center to infinite).

The respective work center and machine cards were enhanced to activate the “Schedule with infinite
capacity” option.
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Scheduling

Unit of Measure Code | MINUTES e | Shop Calendar Code ‘ 2 4 |
Capacity | 4—| Queue Time ‘ 0|
Efficiency | 100| Queue Time Unit of Meas. ... ‘ s |
Consolidated Calendar @ Schedule with Infinite Capa... @

Having activated this setting will be indicated by the oo symbol on the respective work/machine
center:

METRONIC VAPS Open in Excel Acti

Capacities

4 Milling & Turning (=) »

The behavior on such an "infinite" center is the same as on standby resources and subcontractor
work centers. Operations may overlap without driving out each other. Switching on or off this option
will affect the respective center in all existing simulations but operations having been scheduled
already will not be rescheduled automatically.

9.3.Using data filters: filter on capacities

With a data filter you can load only data that you really need (e.g., if you only need to work with data
from your department). This means that these filter settings work as a Dynamics 365 BC data filter on
loading the data into the simulation. Data filters are already effective at the data interface to make
sure that only filtered data are handed over from Dynamics 365 BC to the VAPS. Read more on
creating and editing filters in this chapter.
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Let’s say, in your overall plan there is a capacity “Subcontractors” but in your individual day-to-day
work, this capacity does not matter so that you don’t need to load it. So, what would be more
obvious than creating a data filter for this with the settings shown below?

VAPS Data Filter 7 X

Filter: Work Center Group

#* Name | |

-1 Filter...

Filter totals by:

Filtering by capacities results in loading only production order lines that are assigned to these
capacities via routing. Production order lines that, due to filtering, have no child elements are not
loaded. If lines that are not complete because, for example, an operation is missing because its
capacity is filtered out, the remaining operations are displayed paler and can no longer be moved,
i.e., they are treated as "pinned with blocked capacity". The same applies to production orders.

After opening our newly created simulation with the filter "No subcontractors", you'll recognize
some operations appearing in a pale color and some links being somewhat "interrupted" because the
operations of this production order that are handled by the subcontractors get, of course, filtered
out. The paler color indicates that these operations can't be moved.
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* Name
Code t Name :
T Filter... - 1 Machining | Fertigung o
2 Finishing | Endbearbeitung
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-+ Filter... :
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Filter: Work Center I
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9.4.(Basic) production line scheduling

This feature is helpful for customers with a line-type scheduling approach.

We've encountered certain customers who follow a line-type scheduling approach. Through
collaborative sessions with these customers and their partners and a deep understanding of their
processes, we've identified specific requirements that posed challenges with our initial VAPS design.
This process revealed a plethora of potential features that could enhance the VAPS for more
effective production line scheduling.

Recognizing the substantial amount of work involved, we opted to begin with a minimum viable set
of features that would enable these customers to benefit from the VAPS immediately. Naturally, we

plan to gradually expand this functionality with future releases.

As a first step in this direction, here's what we've implemented (and what we haven't):

9.4.1.

Business Central setup

Define the line as work center

Define each “workstation” (i.e., each process step) as a machine center

Flag the work center as “Production Line (VAPS)”

Example:
Work center = line 1
Machine centers of that work center

O
O

= Stepl
= Step2
= Step3
=  Step4d
= Step5

= NETRONIC
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< Work Center Card | Work Date: 31.01.2024 f = -+
WO00010 - Line 1

Home Work Center Related ~~ Reports »~» Automate .~ Fewer options

@load [EHcalendar B Absence

General
No. W00010) Search Name LINE 1
MName Line 1 Blocked .
Work Center Group Code 1 ~ Last Date Modified 25.10.2023
Alternate Work Center ~ Color (VAPS)
' Posting > 250 | Time MANUFACT
Scheduling
Unit of Measure Code MINUTES i Queue Time 0
Capacity 1 Queue Time Unit of Me... ~
Efficiency 100
Consolidated Calendar o
Shop Calendar Code 2 v

9.4.2. Scheduling: We take the “line dependency” into account

Example:

e 2 work centers flagged as “production line”
e Both with 5 machine centers: step 1 ... step 5

o If the first operation of a production order is assigned to the machine center “step 1” within
work center 2, all subsequent operations will also get assigned ONLY to machine centers

within that same work center 2

9.4.3. Visualization: We also monitor the “physical dependency”

e Once production order 1 is on a certain line, it cannot be overtaken by production order 2

Hence, on each machine center in that work center, the operations of production order 1 must start

and end earlier than the operations of production order 2
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The line dependency is taken into account as
hard restrictions, when you do the following:
* Apply alt. routing (if prod order is on standby)

* Add all incl. alternatives
* (Apply routing and add all only work if your
default routing keeps the line assignment)

Notice: All other scheduling tools currently do
not take the line dependency into account.

Attention: you can violate any of these
restrictions via drag & drop.

DANGER: “fill idle times” will most likely break

up all line dependencies.

9.4.4. How to cope with the limitations

e Two new color schemes
o Production Line Assignment -> gives a visual warning if the “line dependency”
restriction is violated (e.g., multiple operations from one production order flipping
between lines)
o Production Line Sequence -> gives a visual warning if the “physical dependency”
restriction is violated (e.g., one production order overtaking the other)
e Recommendations
o Set your default routings in a way that the line assignment is granted

o Set alternate routing sets so that you can efficiently “fill” all your lines
o When doing line scheduling, trust the automatic scheduling
o Avoid drag & drop as much as you can
o If there are issues (sequence or line assignment violation), move the production
order to standby and reschedule -> all line restrictions will be considered again
= NETRONIC
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